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C H A P T E R  1 I N T RO D U CT I O N

Using MetaStock 17
MetaStock is an all in one toolbox designed to help you identify trading 
opportunities. It allows you to chart, scan for opportunities, test your trading ideas, 
review option pricing, and even forecast pricing based on passed. The elements 
discussed here will show you practical approaches to identifying and managing 
opportunities in MetaStock 17. The ideas and methods contained here will guide 
you on how to use MetaStock and ways to identify trades. However, we 
recommend that you also use the Getting Started with MetaStock manual to help 
you understand the basics of the program. We also recommend that you reference 
the product help within MetaStock. (Open MetaStock and press F1.) Throughout 
this manual, you will find icons next to the text that matches to those found in the 
program. That will help you quickly identify the referenced functionality in 
MetaStock. Most of all, we hope that you find this text and video set useful. The 
companion videos will be especially valuable in helping you follow the workflows. 
You can view the companion videos at www.metastock.com/upm

Disclaimer
This product is not a recommendation to buy or sell, but rather a guideline to 
interpreting the specific analysis methods. This information should only be used by 
investors who are aware of the risk inherent in trading. MetaStock accepts no 
liability for any loss arising from any use of this product or its contents.

Hypothetical performance results have many inherent limitations, some of which 
we describe below. MetaStock makes no representation that any account will, or is 
likely to, achieve profits or losses similar to those shown. There are frequently sharp 
differences between hypothetical performance results and the actual results 
subsequently achieved by any particular trading program.

One of the limitations of hypothetical performance results generally benefits from 
hindsight in their preparation. Additional, hypothetical trading does not involve 
financial risk, and no hypothetical trading record can completely account for the 
impact of financial risk in actual trading. For example, an individual's tolerance for 
loses and discipline in following a trading program in spite of losses are material 
points which can also adversely affect actual trading results. Hypothetical 
performance results cannot fully account for numerous other factors related to the 
markets in general or the implementation of any specific trading program.  All of 
these factors can adversely affect actual trading results

http://www.metastock.com/upm
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C H A P T E R  2 S TA R T I N G  W I T H  M E TAS TO C K

When opened, MetaStock presents you with a box called the Power Console.

The Power Console is the heart of MetaStock and is designed to allow you quick 
access to Chart, Explore, Manage and View lists, Back Test, view and analyze 
options or Forecast. This manual covers all of these and shows you how to use 
them in MetaStock to find opportunities. As you work with MetaStock, you may 
find some workflows more useful to you than others. That is normal. Everyone 
trades differently and manages their trades differently. This manual starts by giving 
you an overview of the Power Console and other tools in MetaStock. Once those 
have been covered; the manual then provides an overview of trading strategies.    
We also recommend viewing the accompanying videos found at 
www.metastock.com/upm.

Opening a chart

Choose the  in the Power Console. The button turns orange when 
selected. This button gives you access the charting functionality inside the Power 
Console.

The first way to open a chart is by typing a symbol directly.  If you know the symbol, 
click on the Instrument(s) line of the dialog box.
Unleash the Power of MetaStock 17 6

http://www.metastock.com/upm
http://www.metastock.com/upm


Chapter 2: Starting with MetaStock
From here, you simply enter your Instrument, and you are then ready to open a 
chart. If you do not know the symbol, you can choose the Instrument Search 
button. That gives you a dialogue which lets you search for instruments based on 
what you know of the symbol or the name. When you enter text, it narrows down 
to instruments that meet your criteria.

For example, select the Name radial button and Starts with. Then type in FORD. 
The box narrows down to a set of symbols that match that criteria.
Unleash the Power of MetaStock 17 7
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Hint: You can 
enter multiple 
instruments into 
the box by 
entering a space 
between the 
instruments.
Select any of the instruments by double-clicking, and it populates automatically in 
the Instrument(s) dialogue.

At this point, you can open the chart; however, there are other ways that 
instruments can be selected. The Instrument Tree is found directly under the Select 
Instrument(s) box. 

The list of securities is the full universe of instruments that are available depending 
on your data subscription. Note that the list in the above image shows 292,818. To 
see all the symbols available, you can select the arrow next to the box showing 
Unleash the Power of MetaStock 17 8



Chapter 2: Starting with MetaStock
“Public Online Data Lists 0 of 292818.  That shows you all the different lists available 
in MetaStock. 

You can continue to select arrows and narrow down what you want to review. 
However, as a trader, your focus is probably only one or two markets. So lets review 
having MetaStock only show the symbols for a few markets. To do this right-click 
on the word instruments:

Select the option Manage Public Lists, and the Public List Editor appears. This 
dialog allows you to see only the lists that pertain to what you want to track rather 
Unleash the Power of MetaStock 17 9



Chapter 2: Starting with MetaStock
than the entire global list. The left window shows the Available Lists. The right 
window shows lists selected to display in the Power Console.

This example shall select the US and Canadian Instruments. Scroll the list down to 
find exchanges to include in your Power Console.   You can select multiple lists at a 
time by selecting the first in the list you want. Then hold the shift button on your 
keyboard and select the last list you want. The selected lists become highlighted in 
blue.
Unleash the Power of MetaStock 17 10



Chapter 2: Starting with MetaStock
Choose the  button. That moves the selected lists over. The right 
window must include at least one header, such as: Equities - North America.

There are several options to choose from, including global stock lists, global 
futures, and indices. There are also lists for Index Constituents. Once your list is 
customized, You can move the entries up and down. You can also create a custom 
header by choosing the  button.

Once you have defined the lists: Choose the  button and your list shall 
only show what you selected in the Public List Editor.

To view the lists in the Power Console, choose the arrow next to the Public Online 
Data lists (notice in the list that the number of instruments has decreased due to 
Unleash the Power of MetaStock 17 11



Chapter 2: Starting with MetaStock
the reduced selection of lists). You can also expand each section to a granular view 
of the instruments included in the list.

Now that the lists appear as we want to see them, it is time to open a chart. For this 
example, we shall use .DJI to open the chart. When you enter text in the Select 
Instrument dialog box, the Instrument Tree becomes grayed out. 

There are three sections to choose defaults or settings for once you open your 
chart.
Unleash the Power of MetaStock 17 12
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You can also change 
the price plot via the 
toolbar in the 
bottom left corner of 
the chart. To do so, 
click on the price 
plot, then click the 
arrow in the menu 
to display the price 
plot options.
After setting your selections, choose .

Many options become available once the chart opens.

Chart Styles and Options
MetaStock provides nine charting styles (price styles) when viewing pricing 
information: 

• Candlesticks
• Candlevolume
• Equivolume
• Kagi
• Open/High/Low/Close Bars
• Line
• Point & Figure
• Renko
• Three Line Break

Option Descriptions

Range How much data to load. 

Load Default 
Record

Automatically Loads 1250 records and Dis-
play records Zooms in on 250 records.

Load Maximum 
Records

 Loads all available data.

Exchange Date 
Time

Specific times set by set by user.

Interval Sets the periodicity of the chart. Defaults of 
Daily.

Apply Template
You can choose from a setting of pre-cre-
ated templates or from user created tem-
plates.

Expert Advisor You can choose from a setting of pre-cre-
ated Experts or from user created Experts.
Unleash the Power of MetaStock 17 13



Chapter 2: Starting with MetaStock
The price plot is the data displayed on the chart by the instrument's price 
information. You can change many aspects of the price plot's appearance, 
including style (e.g., Line, Bar or Candlestick), color, and line thickness.

To modify the properties of a chart, open the chart to be changed. Either select 
Format > Prices or right-click on the price plot and select <instrument name> 
Properties. The instrument’s Properties dialog then opens.

Select the price style, color, or line weight you wish to use. Click  to close 
the window.

Editing Charts

Zooming

Sometimes you want to see a small section of a chart up close. There are many 
ways to change the zoom level:

• Use the Zoom In and Zoom Out icons.
• Hold down the CTRL key on your keyboard and roll your mouse wheel up or 

down.
• Use the Zoom Box icon.

Icon Icon 
Name Description

Zoom 
Out

Click the icon in the lower right corner of the chart 
to zoom out on the chart.

Zoom In Click the icon in the lower right corner of the chart 
to zoom in on the chart.
Unleash the Power of MetaStock 17 14
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Note: Changes 
made to the default 
template does not 
affect charts opened 
before your 
changes. Those 
older charts need to 
be deleted or 
individually 
changed.
Default Template

The Default Template allows you to set a newly opened chart to a predefined look. 
This way, you can have the same set of indicators or color schemes apply to all of 
the charts you open automatically. The default template is a template that is 
exactly like a custom template except that MetaStock automatically applies it 
when you are opening a new chart. The default template that ships with 
MetaStock creates a chart with bars and volume.  

To quickly make the information in the currently selected chart the default 
template, right-click on the chart and choose Save as default template.

Zoom 
Box

Click the Zoom Box icon at the top of the screen, 
then click and drag a rectangle around a section 
of the chart to zoom in on the area within the 
rectangle.

Icon Icon 
Name Description
Unleash the Power of MetaStock 17 15



Chapter 2: Starting with MetaStock
Chart Windows

MetaStock displays each chart in a separate window. There are several commands 
to control how those windows are displayed. Tile and Cascade are common to 
most Windows applications. Stack, Column, and Automatically Tile are unique to 
MetaStock.   These buttons are on the Standard toolbar. 

Indicators
An indicator is simply a mathematical calculation applied to some or all of the price 
fields and/or volume. Indicators can be plotted in the chart to show a graphical 
representation of these calculations.

To learn more about inserting and applying indicators refer to the Getting Started 
with MetaStock manual.

Icon Icon 
Name Description

Cascade This arranges the open chart windows in an over-
lapping formation so that only the title bars of all 
but the front chart are visible.

Column This arranges the open chart windows from left to 
right in vertical columns so that all are completely 
visible on the screen.

Stack This arranges the open chart windows so that the 
charts are stacked on top of each other and are 
fully visible. Arranging them in a stacked forma-
tion allows you to easily compare charts across 
their date axes.

Tile This arranges the open chart windows from left to 
right and top to bottom so that all the charts are 
completely visible on the screen.

Auto Tile This arranges the open chart windows from left to 
right and top to bottom so that all are completely 
visible on the screen. With this selected, 
MetaStock rearranges open chart windows as you 
open or close charts.
Unleash the Power of MetaStock 17 16
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Note: When you are 
clicking on an 
indicator and the 
indicator is closely 
surrounded by other 
plots, a pop-up 
appears prompting 
you to choose the 
desired plot 
(indicator) to ensure 
the correct plot is 
selected.
There are two ways of plotting an indicator in MetaStock. You can choose Insert > 
Indicators to display and use the Indicators dialog. You can also drag and drop an 
indicator from the Quicklist.

The Indicator Quicklist (located on the standard toolbar) provides quick access to 
all the indicators in MetaStock. It also moves to the top, the 20 most recently used 
indicators for easier access. You can drag indicators from the list by holding down 
the left mouse button and dropping them on your charts. 

• If you drop the indicator on an inner window title bar, MetaStock puts the 
indicator in a new inner window above the title bar. 

• If you drop the indicator on the X-axis, MetaStock adds the new inner window 
at the bottom of the chart. 

• You can also drop an indicator on any existing plot. Moving Averages, 
Envelopes and Bollinger Bands are almost always dropped on an existing plot 
since you usually want them merged with a plot.

A quick way to get to the desired indicator in the Indicator QuickList is to display 
the Indicator QuickList and then type the first letter of the indicator's name. The list 
quickly advances down to the indicators beginning with that letter.

After you have plotted an indicator, you can modify any of its properties (for 
example, color or number of periods) with the indicator's properties dialog. Right-
Unleash the Power of MetaStock 17 17
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click directly on the plotted indicator and choose Properties on the shortcut 
menu.

The properties dialog opens, allowing you to edit the properties of the indicator. 
Choose any of the tabs and make your desired changes. Click  to close the 
dialog.

You can also open the indicator properties dialog by double-clicking directly on 
the plotted indicator or by selecting the indicator and then choosing Format > 
Selected Object.

Line Studies
Line studies are one of the most popular tools in MetaStock. They help you see 
trends and patterns in a chart, which can give you an edge when making trading 
decisions. Every line study contains its own set of parameters you can access by 
right-clicking directly on the study. Most line studies plot within a single inner 
window. However, some line studies (for example, cycle lines, Fibonacci Time 
Zones, and vertical lines) can span vertically across all inner windows within a 
chart. 

Line studies are drawn on a chart by either choosing the line study from the Insert 
menu or by selecting the desired icon on the appropriate drawing toolbar. There 
Unleash the Power of MetaStock 17 18



Chapter 2: Starting with MetaStock
are several toolbars with line studies on them. You can cycle through them by 
clicking the Rotate Toolbar button:

Line studies are attached to the plot closest to the mouse pointer when you first 
click to begin drawing.

• If the line study is trendline based, position the mouse at the starting point, 
click and hold the left mouse button, and drag the line study to an ending 
point. Then click the left mouse button again to indicate the ending point.

• If the line study is not trendline based, position the mouse at the location you 
want to anchor it and click the left mouse button.

You can delete a line study by:

• right-clicking on the line study and selecting Delete from the shortcut menu
• selecting the line study and pressing the delete key on your keyboard
• selecting Edit > Delete All or press ALT+DEL to quickly delete all line studies 

from a chart. 
Unleash the Power of MetaStock 17 19



C H A P T E R  3 M E TAS TO C K  P OW E R  TO O L S  O V E RV I EW

The MetaStock Power Tools help you avoid spending time analyzing charts one by 
one. With them, you can quickly: identify opportunities by scanning through the 
market; backtest your strategies; understand the direction of price; and get Buy 
and Sell signals on your chart.   These tools are designed to help guide you through 
the trade and take the emotional aspect out of the trade. It is no secret that making 
emotional decisions in trading can lead to failure. The Power Tools are designed to 
help you as a trader take the emotion out, and protect what is most important in 
trading: your capital and your profits.   This section gives a brief overview of the 
tools and how to access them in MetaStock. 

The Expert Advisor™
The Expert Advisor is a collection of trading strategies which, when attached to a 
chart, can help keep you informed on the current technical state of a chart. It does 
this by using underlying indicators to generate the buy and sell signals on your 
chart. When an expert is attached, you may see:

• buy and sell signals based on indicators
• candle patterns labeled on your charts
• descriptive commentaries based on technical indicators and strategies
• messages (e-mail and pop-up messages with sounds or video)
• descriptive symbols on your charts

To attach an expert advisor, you can select it from the Power Console before you 
open a chart by selecting the expert under the Attachment section of the Open 
Chart Dialog.
Unleash the Power of MetaStock 17 20



Chapter 3: MetaStock Power Tools Overview
There are multiple ways you can access the Expert Advisor once a chart is open. 
You can select the Expert Advisor from the Standard Tool Bar by choosing the 
Expert Advisor icon.

Going to Tools > Expert Advisor
Unleash the Power of MetaStock 17 21



Chapter 3: MetaStock Power Tools Overview
Or Right-clicking on chart and choosing Expert Advisor, then Attach.... 

Once you open the Expert Advisor dialog, select the expert to attach. 
Unleash the Power of MetaStock 17 22



Chapter 3: MetaStock Power Tools Overview
Select . The expert then plots on your chart. Below is an example of the 
Dow Jones Industrial Average (.DJI) with the MACD by MetaStock Expert attached.

To open the Expert Commentary window, for a walkthrough of the signals on the 
chart, choose View > Expert Commentary. That displays the Expert Commentary 
window on your chart.
Unleash the Power of MetaStock 17 23



Chapter 3: MetaStock Power Tools Overview
The Explorer™
The Explorer is a powerful multi-purpose analysis tool that can perform in-depth 
"explorations" on multiple instruments. 

The Explorer lets you perform many specialized tasks, including:

• comparing
• filtering
• listing multiple indicator values for multiple instruments
• ranking
• searching
• showing instruments with current buy/sell signals
• sorting

You can use the Explorer to discover which instruments:

• have just generated a "buy" (or "sell") signal based on the values of an indicator
• have just crossed above their 200-day moving average on increased volume
• rank highest by Wilder's RSI or other indicators
• are above their 10-week moving average, with a Stochastic of 80 or higher, and 

are at a level of 4 on a customized binary wave

You can use the Explorer to generate:

• performance reports of all your mutual funds
• lists of every instrument you want to track
• the values of your favorite 12 indicators you want to track

Access the Explorer by choosing  from the Power Console or by 
choosing the Explorer icon from the Standard Tool Bar.
Unleash the Power of MetaStock 17 24



Chapter 3: MetaStock Power Tools Overview
Once you have selected the Explorer icon, the Power Console presents two boxes. 
One is to choose the exploration (technical criteria), and the other is to choose the 
set of instruments.

Notice that MetaStock comes with hundreds of explorations. To avoid looking 
through the full list, you can add the explorations you use frequently to the 
exploration Favorites. Choose the arrow next to the exploration tree and right-click 
on CandleStick Bearish Patterns. Select Add to Favorites.
Unleash the Power of MetaStock 17 25



Chapter 3: MetaStock Power Tools Overview
The CandleStick Bearish Patterns exploration is now in the Favorites section. Notice 
it still appears in the main list.

You can remove explorations from favorites by right-clicking on them and 
selecting Remove from Favorites. This action does not delete the exploration or its 
report. The exploration is only removed from the Favorites section and is still in the 
full list of available explorations.

For this example, select the MACD Buy Signal. Then expand the Instrument List 
and select the S&P 100.
Unleash the Power of MetaStock 17 26



Chapter 3: MetaStock Power Tools Overview
Once the Exploration and the list are selected, then there are other selections to be 
made:

Option Descriptions

Load Minimum 
Records

Loads the number of records required based on the 
scanning criteria.

Records to load Sets a user-defined number of records to scan.

Exchange Date 
Time

Set the date for the exploration. The date/time is for 
setting a date in the past for reviewing past data.

Interval The time frame for the Exploration

Notify when report 
is ready

If activated, MetaStock displays a popup window 
when an exploration finishes

Use Filter

If activated, MetaStock restricts the results on an 
exploration to just those instruments which meet 
the conditions of the explorations filter. if no filter is 
defined, this option has no effect

Multiple 
Exploration Options

This is for searching multiple lists or using multiple 
filters on the same list. "Explore for opportunities 
using the RMO" on page 113 shows an example of 
this.
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Chapter 3: MetaStock Power Tools Overview
After making all selections, click the  to begin your exploration. Once 
the exploration begins, MetaStock displays a window showing the exploration 
status.

When the exploration finishes, MetaStock displays the report in the bottom part of 
the window.
Unleash the Power of MetaStock 17 28



Chapter 3: MetaStock Power Tools Overview
This report shows an example of the instruments that meet the criteria selected.

To open a chart from here, you can either select and highlight an instrument(s) and 
choose ; or you can double-click on any instrument. Either method opens 
the chart(s) for you. You can leave the Explorer dialogue open while you work with 
charts. You can also select Open All Instruments in QuoteCenter and then use the 
list in QuoteCenter.

The System Tester™
System testing involves the development and testing of trading systems to 
determine the systems' historical profitability. System testing helps answer the 
question, "If I had traded this instrument using these trading rules, how much 
money would I have made or lost?" The System Tester also shows you which 
instruments work well with which systems. MetaStock comes with dozens of ready-
made systems you can use to backtest against instruments. 

You can also test your trading ideas with the System Tester. Including the following:

• one system on one instrument
• several systems on one instrument
• one system on many instruments
• several systems on several instruments

To access the System Tester choose the  from the Power Console or by 
choosing the System Test icon from the standard toolbar

or by choosing Tools > System Tester.

The System Tester options are all located on one screen for you to set your testing 
conditions. This section gives a brief overview. For more detail, see "Filtering and 
Backtesting" on page 54 and "More on Backtesting" on page 65.
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The system test 
favorites and the 
explorer favorites 
are two separate 
lists. Actions 
affecting one 
favorites does not
affect the other 
one..
Once you have selected the System Test icon, MetaStock displays two boxes. One is 
to choose the System Test (technical criteria), and the other is to choose the set of 
instruments.

As with explorations, MetaStock comes with a large number of system tests. 
Similarly, you can right-click on a system test and add it to a favorites list.

Choose the arrow next to the System Test and select the system to be used. This 
example uses the MACD Expert System test. To select instrument(s), either enter a 
specific security in the enter Instrument(s) box or select multiple instruments from 
the Instrument tree.  
Unleash the Power of MetaStock 17 30
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The next step is to set the testing options.
Unleash the Power of MetaStock 17 31



Chapter 3: MetaStock Power Tools Overview
Begin the System test by choosing the  button.

 The System Tester simulation completed dialogue appears when the test finishes.

 

Option Descriptions

Long trades This allows the system tester to take only 
long trades.

Short trades This allows the system tester to take only 
short trades.

Both This allows the system tester to take both 
long and short trades.

Use Last

This allows for a selection of periods. For 
example 250 records would test 250 bars on 
a daily chart or 250 5-minute bars if select-
ing a 5 minute chart.

Exchange data/time This allows for a selection of specific date 
ranges for a test.

Interval
This allows for selection of time frame. For 
example you could test your strategy on a 
daily or weekly chart.

Trade Options

This opens a new dialogue box that allows 
for selections on Reporting, account sizing, 
broker commissions, and trade execution. 
These is covered in more detail in "Filtering 
and Backtesting" on page 54 
Unleash the Power of MetaStock 17 32



Chapter 3: MetaStock Power Tools Overview
Choose the  button to view the system test results. That shows the 
results of the system test. 

The tabs and results show the overall results of the test:

To review the sections and all the categories click on the  button in the top 
right-hand corner. That explain the tabs and all the information contained in the 
results. "More on Backtesting" on page 65 includes how to reference the top 
sections of data and how to interpret them.

The MetaStock Forecaster™
Forecasting is a science that allows us to look at how price behaves after an event 
has occurred. An event can be anything from a Moving Average Crossover to a 
single day Candlestick pattern. The ranges of events can be varied; however, our 
main concern as traders is, "what happens to price after an event happens?" Does 
price tend to move up, move sideways, or trend down? These are the questions 
that The MetaStock Forecaster helps answer. We can see a confluence of prices in a 
Forecast Cloud so we can observe what price tends to do. 

The Forecaster allows you to: 

• See a Forecast Cloud of how price trends up to 180 days after an event occurs
• Scroll through relevant events (up to 67) to see past performance.
• See past events plotted on the chart and how those past events performed. 
• Use the explorer to find events and then match them in the Forecaster. 
• Show higher intensity price probability by showing brighter colors.
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Chapter 3: MetaStock Power Tools Overview
Example Forecast Cloud:

To access the Forecaster choose  from the Power Console or by 
choosing the Forecaster icon from the standard toolbar 

or by choosing Tools > Forecaster. The Forecaster can also be launched from any 
active chart by right-clicking and choosing Forecaster.

Choose which Instrument to open by either selecting the Instrument(s) dialogue 
box or from the Instrument(s) tree. 
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This example uses .SPX. 

Selections for forecast use the following.

Option Descriptions

Load default 
records

Loads 1250 Periods of data.
This is the recommended option as loading 
more data may negatively affect the Fore-
caster’s calculation speed.

Load maximum 
records

Loads the full data history

Exchange data/time Load specific date ranges selected by the 
user.

Interval Loads Daily chart

Options Launches a new window giving options for 
recognized events.

Start Forecaster Launches the Forecaster Application
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Once the Forecaster is launched, it opens as a new, separate charting application. 
An example of the Forecaster window appears as below. 

The Forecaster shows a chart with yellow triangle arrows above and below the 
price chart. These are not indicative of buy and sell arrows, but show when an 
"event" occurred. The event can define a technical set up or when the signal 
occurred. Do not confuse them as Buy and Sell alerts. Here is an example chart with 
event markers. 
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Below the chart is the list of recognized events with options for sorting. 

After you chose an event, the Forecaster gives a Statistical Report. It also shows 
Event Dates under the events date tab. 

The probability scale allows you to select the probabilities you want to view.   You 
control that by moving the scale from low to high. 
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Selecting the Forecast Cloud tab displays the current forecast cloud for the 
selected event.

"Using the Forecaster" on page 74 includes more detail on how to use the cloud.

QuoteCenter
QuoteCenter is a multi-function tool to see the current status of the securities in 
which you are interested. You can view your pick list, your positions, your indices, 
or any other list you choose. More than that, you can easily build and set up lists 
using QuoteCenter. 

Sort on a variety of criteria to view the data important to you, then double click on 
a security if you want to see a chart. It’s a fast and easy way to make your workflow 
more efficient than ever. You can even change the color theme. 

Depending on the version of MetaStock you have depends on the type of data you 
can see. MetaStock R/T customers have the option to view data in real-time.* 
MetaStock D/C customers can work with online data from Datalink or use your 
offline data in MetaStock compatible format.

• View Symbol, Name, Tick, Last, High, Low, Open, Open Interest, Volume, Net 
Change, Percent Change, Date (or Time in MetaStock R/T, as well as Bid and Ask)

• Open Charts directly from QuoteCenter with just a click
• Open any list from Power Console (up to 600) 
• Select any group of stocks to open in QuoteCenter
• Create and Manage lists
• Sort and rank on columns
• 3 available color themes for viewing quotes 
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You can access QuoteCenter by choosing  from within the Power 
Console or by choosing the QuoteCenter icon from the Standard Tool Bar.

From here, you can easily select lists to work with or build a custom list to use 
instead. This section covers how to build a list or use a prebuilt list. We shall first 
open a list using a prebuilt one included in MetaStock. 

Once you select the QuoteCenter icon, the Power Console presents you with your 
lists.  If you followed the instructions in the previous chapter and narrowed down 
your lists to markets you follow, only those lists appear; otherwise the global lists 
appear. Either one is fine. This example includes North American Securities, but the 
procedures for opening any list (including local) is the same. The only difference for 
local lists is that the lists display under the local lists section.
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This example uses the S&P 500 list. Select the box next to this list, and the next 
pane then displays the symbol list of the S&P 500.

If you want to open this list as is, choose . However, before we 
proceed to open the list, let’s review what to do if you want to make changes to the 
list. If you select any of the instruments in the Selected Instruments dialogue, they 
become highlighted in blue. To make multiple selections, hold down the shift 
button and drag your cursor to highlight in a row, or you can use the CTRL + select 
to highlight multiple selections. After highlighting some instruments, you can 
select  to delete those items from the list. 
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Deleted those instruments reduces the size of the S&P 500 list.

With our list customized, choose . This launchs QuoteCenter. 

Different versions of MetaStock use different headers in QuoteCenter. For example, 
instead of "Time" in R/T, D/C shows "Data" in D/C. D/C also does not provide Bid/
Ask data. The source column tells you if you are looking at data that is online or 
offline data.
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Any of the column headers that you see are also sortable.  You can click to sort 
ascending and double click to sort descending.  This image shows volume sorted 
in descending order.  Note: Volume shows a down arrow denoting descending 
order:

If you wish to add to the list of securities you can enter the symbol into the Add 
Instruments box.

And then choose Add.

This adds the new instrument(s) to your list and bolds it.

When your list is displayed, you can use QuoteCenter to open charts and have 
them displayed in MetaStock. Do this by double-clicking anywhere that contains 
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data on the symbol you want to open. That action displays the line item that you’ve 
double-clicked.

Each chart you open appears in MetaStock. You can also open multiple charts at a 
time by holding shift and selecting a group of stocks, or CTRL + Click to highlight 
multiple instruments.

Alternatively, you could delete the selected items by choosing the delete option. 

Once you are done working with your list, you can either discard your changes or 
save them. If you do not want to save your changes, close QuoteCenter and then 
say no when asked to save. The rest of this section explains how to save your list. 
Unleash the Power of MetaStock 17 43



Chapter 3: MetaStock Power Tools Overview
QuoteCenter gives a list a temporary name called "QuoteCenter List 1" (or assign 
another temporary number). If it assigns another number than 1 that means it 
already saved a list 1. You can use the QuoteCenter naming by clicking save, or you 
can give it a different name by clicking Save as.

You would then give your list a name and choose save.

After you save a list, you can exit out of the QuoteCenter App without losing it. If 
we want to use it again, we can return to the Power Console and view it under the 
QuoteCenter Tab.
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You can open the list from here, or you can go to the Use Existing List tab. Highlight 
the list and click . All the custom lists you have created show up 
under “Use Existing List.”

OptionScope
OptionScope puts all critical info at your fingertips. The OptionScope option chain 
display gives you sortable, customizable, color-coded options data – including the 
greeks. 

The OptionScope filter window makes honing in on the data you want to see a 
breeze. Of course, MetaStock’s legendary charts are just a click away, saving you 
time and effort. 

• MetaStock D/C customers can view Option Chains for any US Optionable Stock 
(requires additional options data)

• MetaStock R/T customer can view Real-time Option Chains for any global 
optionable equity*

• View Puts/Calls with Net Change, % Change, Bid, Ask, Implied Volatility, Close, 
Open Interest, and Volume

• View Greeks: Delta, Gamma, Theta, Vega, and Rho
• Sort by Expiration Date, Strike Price, Filters, Expiration Type, In/Out of the 

Money and Greek Parameters
• Filter on Expiration Date, Strike Price, Expiration Type, In/Out of the Money, At 

the Money, and Greeks.
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Choose  in the Power Console.

Alternatively, you can choose the OptionScope button from the Standard Toolbar.

You can also open OptionScope for any open chart by right-clicking on an open 
chart and choosing OptionScope.

Selecting to open OptionScope from the Power Console gives the most flexibility, 
allowing you to filter the data before OptionScope opens. The workflow presented 
here will cover opening from the Power Console. You can analyze one security at a 
time in the OptionScope app. This workflow uses the symbol AAPL.O in the 
OptionScope app. Begin by typing the instrument into the Instrument line of the 
Power Console. If you do not know your symbol, you can use the instrument search 
to identify the symbol you want to use. Remember that the symbol must be 
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optionable, and you must be subscribed to the correct data to be able to access 
OptionScope.

Before we select to open OptionScope, you can narrow down the results of what 
you choose to see if you prefer. For this workflow, select Options that expire in the 
next 90 days, is within 15% of the strike price, and all expiration types. More 
selections are available when OptionScope is open. Proceed to choose 

.
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MetaStock presents you with a grid view of OptionScope.
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On the left side, OptionScope shows Filters in which you can further narrow down 
the options you want to view. You can expand any of the Filters by selecting the 
down arrow next to each Filter Type.
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You can also note that each filter that OptionScope highlights in black each filter 
that you applied. In this case, you can see the same filters selected in the Power 
Console are applied. 
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You can change the filters by simply selecting any filter you choose, or you can 
reset by selecting the clear all filters.

OptionScope displays the data In the Grid Section with Calls on the left and Puts on 
the right. Expiration Date of the Option and Strike Price appear in the middle. Rows 
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colored blue indicate that option is In the Money. Out of the Money options appear 
in gray.

You can see by applying different filters that you can narrow down the data that 
appears.

Once you’ve narrowed down the filters and want to be more specific, it is possible 
to double click on any of the options listed, and MetaStock opens a chart of the 
specific option. The example below selects two options and shows the 
accompanying charts.

For help with how to use any of the columns you can refer to the help in 
OptionScope.
Unleash the Power of MetaStock 17 52



Chapter 3: MetaStock Power Tools Overview
Indicator Builder™
The Indicator Builder is a tool that allows you to build and design custom 
indicators. MetaStock comes prebuilt with a large collection of tools that are ready 
to use; however, you have the ability to custom design your own indicator sets. To 
learn more about the Indicator Builder, go to  
http://www.metastock.com/customer and look for the Formula Primer. That book is 
a free resource that shows you the basics of MetaStock formula writing. 

See the related video at www.metastock.com/upm

Downloader
Downloader is a program designed to help you manage local data. With MetaStock 
XV and higher, you can read data files that are stored locally on your computer. The 
Downloader program collects and stores that data. Downloader uses Datalink™ to 
save data directly to your hard drive. It also lets you convert other files into 
MetaStock data format. Data management is very easy and covered in "Working 
with Local Data" on page 127.
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Why Filter and Backtest?
A sound approach to finding tradable stocks (or any asset type) with MetaStock is 
using a simple three-step approach:

1. Use the Explorer to filter a large list of stocks to find those triggering a trading 
system's active buy (or short) signals.

2. Use the System Tester to backtest the trading system's buy/sell rules to 
determine historical profitability.

3. Use the Expert Advisor to inspect the trading system's buy/sell signals on chart 
AND to monitor the trading system for future buy/sell signals.

This workflow allows you to take your instruments (stocks, futures, or FOREX) and 
narrow them down to the instruments that meet your criteria. You can start with a 
custom list of your favorite instruments, a common list like the Nasdaq 100, or any 
worldwide exchange.

Once you have identified the instruments that meet your criteria, you can backtest 
the stocks to see how the trades performed. This process gives better insight into 
which ones may work best.

Filtering Instruments
Access the Explorer by choosing  from the Power Console or by 
choosing the Explorer icon from the Standard Tool Bar.
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Once you have selected the Explorer icon, MetaStock presents two boxes. One is to 
choose the exploration (technical criteria), and the other is to choose the set of 
instruments.

Choose the arrow next to each tree to expand and select the exploration and the 
list. This example selects the MACD Buy Signal and the S&P 500.
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Choose . Once the exploration starts; a window opens showing the 
exploration status.

When the exploration finishes, the report is displayed in the lower half of the 
window.
Unleash the Power of MetaStock 17 56



Chapter 4: Filtering and Backtesting
This image shows an example of the instruments that meet the criteria selected. 
Depending on the number of results, it may be difficult to decide which instrument 
to trade. The System Tester can help us to determine which instruments to trade. 

Backtesting Instruments
To System Test the results of the Exploration, close the Exploration Results, return 
to the Power Console and choose the System Test icon.

In the System Test tree, select the system to match the exploration. In this case, 
select the MACD Expert System, and in the Instrument Tree, select the Last 
Exploration Results List (Hint: This list always shows the results of the last 
exploration).

For the options, since we scanned a buy signal, let's perform the test on Long 
Trades only. The Range can be variable. The default is for the last 250 records or 
one year of daily data. For this example, change the range to 500 records, or two 
years to give a long testing period. 
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Choose Trade Options.

Click on the Account tab. Here set the Initial Equity to the amount you having in 
your trading account, then change the Default Size to Percent of Available Equity. 
Under this category, choose the amount you are willing to risk in the trade.   In this 
example, select a risk amount of 30%.
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Select the Broker tab

 

Here the commission tab allows setting the cost of the trades for a more realistic 
result. This option can be left blank if the user chooses to test this way. For this 
example, set the commissions as $7 to enter a trade and $7 to exit. 

 For the person new to MetaStock and System Testing it is recommended to leave 
the Reporting and Trade Execution tabs as the defaults.
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Close the System Test Options page by selecting the  button. In the Power 
Console, select the  Button.

Once the System Test is complete, an option to view System Test results is 
displayed.

Select the  Button.
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The results are now displayed.

The Test View opens. The graph at the top shows the average net profit.
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The bottom grid gives quite a bit of information.

The columns tell us a few bits of important information.

Any of these results can be selected to rank based on that criteria. Double click any 
header to sort on that criteria.   In the example below the net profit has been 

Name Description

ID Represents the Test Number

Security The name of the tested instrument

Symbol The symbol of the instrument tested

Period What time frame was tested

Date Range This displays the time over which the test was run

Net Profit The amount of profit that is net minus commis-
sions

% Gain Displays the percentage gain or loss

Trades Number of trades taken over the tested period of 
time

Trade Profit/Loss Number of Winning Trades/Losing Trades

Average Profit/
Loss

Tests average profit and loss
Unleash the Power of MetaStock 17 62



Chapter 4: Filtering and Backtesting
double-clicked to sort on that header. Now the Instrument with best trading 
success has been ranked on top.

Before going into more detail, there is much to learn in the Test View screen. One 
main question is does this fits your individual risk and trading style. This test ran 
over 500 days (2 years). Looking at the first instrument, note that it traded 54 times 
over that period or about once every 9 days. Question 1 is, does this fit how often 
you want to trade? The second question is Trade Profit/Loss. This system, on 
FTNT.O (at the date of the test) had 34 total trades. Of those trades, 30 were 
winners, and 24 were losers. So this system works about 55% of the time, and yet it 
is a profitable system. That can tell us that when it wins, it wins big. It can also tell 
us when the system loses trades; the trades are often smaller. That would be 
something to consider, but it is important to get more detail first.

To get more detail, choose an instrument by double-clicking the instrument name.  

The overview page gives specific details on the trades. The information provided 
includes Highest Profit/Lowest Profit, Trade Timing, Out of market, and others. The 
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accounting section shows the change in the account, including Trade Profit/Trade 
Loss and Commission paid. That allows for a good insight into trades over time. 

The best way to quickly identify if a system has traded well over time is to review 
the Equity tab. Select the Equity Tab.  The top section shows the Equity Line (or 
money over time).

When looking at an equity line, it is important to look for growth over time without 
major drawdown (loss in funds). The Equity line above shows this type of growth 
except for the period between 280-350. The growth has flattened the last 50 bars. 
That is important as it is the most recent trading period. Note that the most recent 
period is the most relevant as it is more relevant to the current market.

Looking for strong, steady equity lines is critical to finding a good system as it 
shows consistent trades over time. This example is a good example as the most 
recent trades have been the best trades.

Open the Chart and apply the corresponding expert to follow the trend.

See the related video at www.metastock.com/upm
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It is no secret that everything trades a little differently. It can be difficult to match 
the personality of a system to the personality of the instrument that you are 
trading.   For example, Apple may trade very differently from Bank of America. The 
EURO may trade differently than the YEN. It may make sense to use an oscillating 
indicator on one and a trending indicator on another. Since each instrument is 
unique, the system tester allows the user to test their strategy against another to 
see if the personalities match. The drawback to backtesting is that it is historical. It 
is a view of how it has performed historically. The increased confidence in a system 
that performs well historically can provide an edge in your future trading. While 
system testing is no guarantee of success, it helps us put the odds in our favor. 

Performing a Multi-System Test
This example tests WalMart against the Performance Systems included in 
MetaStock. You can apply this workflow to any instrument; this is just one example 
of how multiple system testing works. This work flow takes 1 instrument against 26 
strategies to see which of the systems best matches the personality of the 
instrument.

Click  to open the Power Console.

Select  in the Power Console 

In the Power Console, select the 26 System Tests that begin with PS (Performance 
Systems) and the Instrument Dialog Box enter in WMT (or the instrument you want 
to test). Hint: When selecting multiple systems, you can select the first system in a 
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range, then hold down shift, go to the bottom of the range and select, and that 
selects the group.

Once the instrument and the systems are selected, the Trade options need to be 
selected. 

When running the test, you usually set the parameters to your personal trading 
preferences. For this example, set the trades as Both. That tells the System Test to 
trade both long and short. Set the Range to 500 records (or two years on a daily 
bar). Then set Interval to Daily. 
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Select the  button.

 Select the Account Tab:

For this example, set the Initial Equity to 10000 and set the Percent of Available 
Equity to 30%. That tells the system to trade 30% of whatever funds are available 
in the account. This amount can vary depending on if the account drops to 50000 
or increases to 700000. Each trade uses 30% of the equity available at the time of 
the trade signal.
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Select the Broker Tab

For this example, use Points per Transaction. This setting denotes how much it 
costs to enter a trade and how much to exit a trade (commission). Set this to the 
amount that you pay to place your trades.

Select .

Begin the system test by selecting the  button.
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When the test is completed choose the  button to review the results 
of the test.

Reading the Report
Below is the System Tester - Test View screen for the test we just ran. It shows an 
overview of all the systems used in the test.

The Columns represent the following:.

Name Description

ID Represents the Test Number

Security The name of the tested instrument

Symbol The symbol of the instrument tested

Period What time frame was tested

Date Range This displays the time over which the test was run
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To sort on columns double click on the headers. For this example, double-click on 
% Gain. The report then shows the top results based on % Gain.

By looking at this screen, we can already see systems that we would not likely trade 
(those in the negative). That shows we have a few strategies that seem to match 
the personality of Walmart. Double-click on a test result to review the specific 
details of that test. For this example, select PS MACD Histogram 1. 

Net Profit The amount of profit that is net minus commis-
sions

% Gain Displays the percentage gain or loss

Trades Number of trades taken over the tested period of 
time

Trade Profit/Loss Number of Winning Trades/Losing Trades

Average Profit/
Loss

Tests average profit and loss

Name Description
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The summary page gives an overview of how the trades have performed over time. 

The critical test for this will to be to review the Equity line. The Equity line shows 
how the instrument has performed.   Select the Equity tab after reviewing the 
Summary Tab.

Think of the Equity line as a trend line. This example shows a consistent movement 
in the upward direction.
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Using the Equity Line as a gauge of the trades, you can quickly identify those that 
don't work. Consider an Equity Line that appears as below. 

The movement is up overall but with a lot of movement up and down. That shows 
whipsaw in the trading and inconsistent trades. That is not the type of movement 
we want in our trades. 

Looking at several inconsistent trading results shows the importance of looking for 
a smooth, consistent Equity line. 
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Once you decide on a system, go back, open the chart, and apply the appropriate 
Expert Adviser. The Expert can help guide you through the chart and signals 
available.

See the related video at www.metastock.com/upm
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As traders, we can see where the price has been and what the patterns look like on 
a chart. However, the biggest question we always ask is, "Where is the price going 
to go next?". That question is critical to a trader, and the MetaStock Forecaster can 
help see a glimpse into that answer. What we can see with The Forecaster is the 
probability of where prices tend to go after an "event" has happened. We define an 
event as a point in time when a technical signal was confirmed. That could be 
anything from a moving average crossover to a 52 week high. The question is, 
where does the price go after these events happen? Does it rise? Drop?

The way the Forecaster looks at a chart is to analyze the event happening. Meaning 
that when doing analysis, you aren't looking at buy and sell signals, you are only 
looking at when a technical set up occurs. For example. Below is a chart that shows 
only MACD buy signals.

The Forecaster analyzes each of the events and shows what happened to the price 
after the events. It expresses that in the form of a probability cloud.
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This example is showing what the BK does after a MACD Cross up (or buy signal) 
occurs. The price shows a short term flat period before moving down. So if you are 
trading the MACD on the BK, it tends to have a slight increase before a pullback. 
Information like this can help traders understand what happens to price after a 
technical event. It is determined by doing multiple layers of statistical analysis to 
help us determine the direction of price over time. More than that, it can help us 
find where the price is likely to be and where we should be setting our price targets 
and stops.

Opening a Forecast Analysis
Open a Forecast chart:

Click  to open the Power Console

Choose the Forecaster Tab .

In the Power Console either select from the Instrument Tree or type in to the 
Instrument(s) selection box. For this example BK will be used. 
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After selecting the instrument, start the Forecaster by clicking the  
button.

The Forecaster application launches.
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The Forecaster opens and defaults to a screen that shows relevant recognized 
events. From this screen, we can choose recognized events, view statistical reports, 
and view the forecast cloud.

Item Description

1 Choose between the Forecast Analysis and a list of available Event Recog-
nizers and their descriptions.

2 Choose to view a chart of price bars and all previous events.

3 Choose to view the current Forecast cloud for security

4 View of the current Forecast Cloud

5 List of all recognized events and ability to sort and rank.

6 View the statistical analysis of the event and the security. 
Unleash the Power of MetaStock 17 77



Chapter 6: Using the Forecaster
Probability Clouds
To begin the workflow: 

Choose the Forecast Cloud tab 

The Forecaster then displays a cloud.

Note in the cloud that it says Past Performance in the box. The past performance 
means that it is showing a probability cloud. What price has done historically, 
based on the event, determines the cloud. This event is 52 Weekly High.
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1

2

3

4

First the cloud will be reviewed.

The recognized events screen allows a user to choose from different events. Each 
event is it's own technical set up. The checkmark next to the event means that the 
event is viable for review. If you see an exclamation mark, it means that there were 
errors (usually meaning not enough events). 

Item Description

Percent movement. This shows a positive and negative scale.

Days after the event is recognized

Probability scale. This shows the percentage of probability and displays by 
color. The scaling can change if the slider is used.

Forecast length. This changes the number of days focused. For example, 
the current cloud shows 180 days. This can be refocused to 30 (or 90) by 
changing the time frame.
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Choose a different event by selecting the name of the event, and the cloud focus 
then changes based on the event selected. For example, choose the sorted by 
criteria Most Accurate Current Forecast. The display changes in this example as 
the top criteria is now 5 Days or More Up, and the cloud forecast has changed to 
reflect this new selection.

Finally, the statistical report shows the report of the event. There are three tabs. 
The Statistical Report shows an overview of the signals and their statistical 
relevance. The second tab Event Locations shows when that the event(s) 
occurred. The Errors and Warnings tab provides details for any event(s) flagged 
with an exclamation mark. 
Unleash the Power of MetaStock 17 80



Chapter 6: Using the Forecaster
The cloud tells a story to help us understand how we should be managing our 
money with the trade. The new cloud is one with more statistical relevance. To 
understand why we look at the cloud. Let's examine this display in more detail.

The bright colors that display on the chart show that there is a higher probability of 
prices moving in that direction. Using the probability scale on the right side of the 
chart it can be noted that the bright colors of red and yellow show the highest 
probability.

This chart shows that after a 5 Days or More Up Signal, prices tend to stay with a 
range up/down of 5% over the 1-14 days. After those 14 days, it then probably 
makes a move upwards of 10% with -2% on the low end.   Since you are a trader, 
how would you use this information? Trading is all about price and time. If you can 
expect a return in your trade, wouldn’t you use that information to help manage 
your trade? Of course! That is where the power of the Forecaster comes in. Now 
that we understand that based on probabilities that BDX tends to rise 5% (on the 
edge of high probability) and that it takes between 14-30 Bars (in this case days) to 
get there. (Remember you can choose the time frame you want to analyze from the 
Power Console). Then we now have a trade expectation. We know that our target is 
around 5% on the trade and it takes that time range to get there. In following the 
cloud, you can see that after 45 days, it loses its momentum and tends to pull back. 
So as a long trade, we have our time and profit expectancy. This is a very powerful 
aspect of trading!

Another way to use this as a trader is for options trading. If you are trading options, 
this can be even more powerful as it shows us the time and value, but now we can 
better gauge puts and calls. In this same example, it would be fairly evident that a 
call 60 days out would be the best as it takes around 30 days for the max move of 
the trade and you don’t want an expiration before you’ve gotten your best move.
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Comparing Prices to the Cloud
To compare how past events worked with the cloud, we can return to the Price, 
Volume, and Event Markers tab. 

This tab shows the chart with yellow markers.

It is important to note that they are not indications to get in and out of trade, these 
are markers showing each time that the technical signal occurred. 

If you select any of the event markers, the forecast cloud displays using any data 
from the selected event marker back. This distinction is important as it is showing 
how the cloud from that date back would have worked. It is a visual backtest of the 
event and the probability cloud. 
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Here is an image of the last event.

It is interesting to note that for the most part, the price stays contained within the 
probability cloud. There are times that it tries to break out of the cloud. When price 
achieves a top of the probability or bottom of probability, then it tends to reset. 
Think of it as a type of support and resistance.

At this point, please note a distinction. The probability cloud on the chart only 
calculates on data from the selected event back. As new data comes in the chart on 
this tab is not updated. So it can be visually tested.

The cloud displayed in the Forecast Cloud tab includes all load data, both before 
and after the event. That allows Forecaster to build a more relevant cloud.
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These two events are from the same event but note that while the primary shape 
and curves are the same, the coloring is becoming more statistically important 
while new data comes in. 

It is important to use both clouds together to help understand the direction of 
price and your current place in price.

There may be times when working with the Forecast that the Probability cloud has 
no clear direction as the example below.

This does not mean that the Forecaster is not working. It simply means that the 
price did not give a clear and meaningful probability. That means that it is best to 
avoid the signal and avoid a trade that does not provide a clear direction based on 
the probability cloud.

The Forecaster is a critical tool for traders to help understand the timing and 
movement of their trades. Using this tool as a guide to entries, exits, stops, and 
targets can help improve the odds of success in trading.

See the related video at www.metastock.com/upm
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C H A P T E R  7 F I LT E R I N G  A N D  F O R E CA S T I N G

This chapter discusses how to find opportunities in the market using the explorer 
and then go directly to the Forecaster with the list.   As discussed before, the ability 
to find a trade and then move directly into managing it is an important part of 
trading. With this example one can quickly identify a trade and then go directly to 
the management of the trade. This procedure does not discount the need to 
backtest but is another workflow that can be used depending on how you prefer to 
manage the trade.

Scanning for Events
In the Explorer, we matched the 67 event recognizers with an exploration. That 
allows us the ability  to quickly pick an event, scan for it, and then Forecast.

Click  to open the Power Console.

Select  in the Power Console.

This example uses the Forecaster - Moving Avg 50 Cross Up (The close has 
crossed above a 50 period simple moving average on increasing volume) against 
the S&P 500 Stocks.

Choose the Exploration: Forecaster - Moving Avg 50 Cross Up and the S&P 500 
Stocks in the Power Console.
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Use the defaults settings in the Explore tab and set the time frame to Daily to 
match the Forecaster.

After completing these selections, choose .
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This starts the Exploration.

The report appears.
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The following information displays with the results of the scan. (Note that each 
exploration shows different information as part of the results):

In this example, there is one result from the S&P 500 that is crossing the 50-day 
moving average. Double-click on the result to have MetaStock open the chart. If 
there were multiple results, you could highlight all the results and then click 

.

Column Description

Instrument 
Name

Company name or Security Name

Close Last closing price

50 - per Value of the 50 Day Moving Average

Volume Last report Volume price

Avg Vol Volume Average with a 20 period simple moving 
average.

Ticker Symbol Symbol used in MetaStock
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Charts open for all of the selected results.

From the chart, you can see that it has crossed the above the 50-period simple 
moving average and that it has increasing volume. Note that this does not plot 
automatically and you would need to add these for visual purposes. We added the 
circles for instructional purposes.

Opening Forecaster Analysis from Charts
To send the open chart to the Forecaster right-click in the white space, and a 
dialogue box appears. From there, select the Forecaster option.
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This opens Forecaster and makes the selected instrument available to analyze. 

However, when the Forecaster opens, it does not automatically default to the 
recognizer used by the exploration. Choose the matching exploration in the 
Recognized Event box.
Unleash the Power of MetaStock 17 90



Chapter 7: Filtering and Forecasting
Once selected, this gives the correct Forecast cloud to match the exploration.

From this Forecast Cloud, you can observe that after a cross above a 50 day Moving 
Average on ADM, the price tends to rise over the next 30 days. It shows a maximum 
increase of 10% in high probability range and 15% in the lower probability range.

Since this is a current signal (event), the cloud could be used from the starting 
point and then monitored as part of a trade setup, if you took the trade.

You can do the same with the other open charts in MetaStock. By right-clicking 
and then choosing Forecaster in the menu, you can open several charts.

These tabs allow you to selecting through multiple charts by clicking the different 
tabs.
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Optional Workflow:
As an optional workflow to open charts, a user can run the Exploration then go 
back to the Power Console, choose the Forecast tab, select the Results of Last 
Exploration tree to open all charts.

See the related video at www.metastock.com/upm
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C H A P T E R  8 F O R E CA S T I N G  U S I N G  C H A R T  PAT T E R N S

Hidden inside every chart is a story - a story about where the price has been and 
where it might go in the future. Some stories are obvious. Others are a little more 
difficult to figure out.

Charts tell these stories with patterns. Chart patterns are pictures or formations 
made by the price movements of the stocks or commodities you're examining. 
Numerous studies have repeatedly shown that these patterns have excellent 
predictive value. For this reason, the ability to draw patterns and forecast based on 
them was the next logical step in the Forecaster. 

There are two ways to work with patterns in the Forecaster. One is to hand draw 
patterns; the second is to copy patterns directly from a chart. This workflow 
demonstrates both methods.

Hand Drawn Patterns
To begin click  to open the Power Console

Choose the Forecaster Tab .

Enter an instrument to begin. For this example, select Apple (Symbol: AAPL.O). 
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After selecting an instrument, click . 

The Forecaster application then opens with the default settings. 

Select the Recognizer Library Tab.
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This tab displays a list of all built-in recognizers.   When this is displayed click the 
 button.

That button  the Price Pattern Editor
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For this example a v Pattern will be used.

To draw a pattern start in the Pattern Shape, Location and Orientation box.   Start in 
the corner and hold down your left mouse button while you draw a pattern. The 
pattern appears as you draw it. After you finished the pattern, let go of the mouse. 
You can modify the pattern but selecting any of the circles on the pattern and 
doing a drag and drop to how you would like it to appear.

This example shows a hand-drawn pattern in the shape of a V.    A few notes on the 
Price Pattern Editor. 1) It is helpful to change the Approximate Price Bars to reflect 
the length of time that your pattern could show. The default is 15 bars, but this 
example uses 8 bars. Changing the pattern length up or down can change the 

Ite
m Description

1 Enter a name for your pattern

2 Give a description of your pattern

3 Draw your pattern

4 Run a quick test against security data.

5 Methods for determining shape, length, and compatible price intervals.
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number of patterns displayed. 2) Changing Sensitivity can also change the number 
of patterns displayed. The medium and high settings are the most selective. 3) 
Using the Pattern quick test lets you scroll through the chart data and look for price 
pattern matches. See below:

The Pattern Quick-Test shows you a percentage similarity that allows you to scroll 
through the chart to display how the pattern matches your chart. You can choose 
which Security to display. Now that the pattern is done click the  
Button to save the pattern.
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Your pattern now shows in the Event Recognizer Library. They display in 
alphabetical order.

The Forecaster cannot display the pattern on the chart yet. Click the 
 button to look for the patterns.

Once you have selected the  button the pattern appears in the 
drop-down list of available events if the pattern has enough recognized patterns. 
Unleash the Power of MetaStock 17 98



Chapter 8: Forecasting Using Chart Patterns
Here the pattern is displayed in the list. Remember you can sort the list in different 
ways so the event may be in different places based on rank. We sorted this list by 
recognizer name.

In this example, the pattern shows 13 times on Apple.

The chart displays a pattern quick match and how well the event was recognized. 
Put the cursor over any of the event markers. Forecaster then displays the pattern 
with a graphical display of the pattern match.
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Select the Forecast Cloud tab. 

The Forecast Cloud is displayed. To review the differences between the Clouds in 
the Forecast Cloud tab and the Prices tab, see “Comparing Prices to the Cloud” on 
page 82.

This pattern shows a high tendency to move up after a V Shape event. The cloud 
shows a tendency to move up within the first 14 days with a deviation after 30 
days.   Using this pattern would be most useful within the first 25 days before the 
deviation begins. Remember that the Forecast Cloud on this tab continues to 
update with new data while the pattern on the Price, Volume, and Event Markers 
tab remains static, only using the data from the event back.  

At this point, we should review the last event marker on the Price, Volume, and 
Event Markers tab.

Choose this tab and then click the last event marker arrow. After highlighting the 
last event marker, the pattern turns yellow, and the confidence test appears.   The 
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result for this event is recent (within one bar), so the pattern displays at the end of 
the chart.

We can see the high probability in the chart and can use this to help set our price 
and time targets as described in the Forecaster chapter.

Copying Patterns from Charts
The second way to set up chart patterns is to copy them directly from the chart.   
There are several ways to identify patterns with charts. 1) To find a pattern that you 
see repeat within a chart and copy it or 2) To copy the last pattern that is occurring 
on the chart. This workflow uses option #2. Finding a pattern that is in current 
formation used along with a buy signal can be a powerful combination. For 
example, a high probability cloud based on a formation can provide trade 
confirmation and help give price targets and stop settings.

Coca Cola (Symbol: KO) is the example in this workflow. The image below shows 
that the MACD has a current buy opportunity. If this opportunity were taken it 
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would be a strong benefit to know if the current price pattern will give a strong 
directional guide for target and stop settings.

To open the Forecaster from an open chart, right-click in the clean space and then 
choose Forecaster.
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When the Forecaster opens, select the User-Defined Pattern Select Box and then 
drag around the pattern to be selected. The gray box on the chart emphasizes this.

IMPORTANT: The selected pattern must be at least 3 bars long and cannot exceed 
250 bars.

The dialogue box then prompts to capture the selected area as a user-defined 
pattern
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Select the  button. Now the Price Pattern Editor box appears, and you can 
edit the variables.

The box shows the pattern in the Pattern, Shape, and Orientation box. Any of the 
points can be modified by selecting the waypoints and dragging and dropping. 
The Approximate price bars equals the pattern you s on the chart. Before saving 
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the pattern change the ENTER NEW PATTERN NAME HERE with a name. This 
example uses the name of the security with a brief description. 

Note that on the Pattern Quick-Test that the Pattern matches 100% since it was 
selected directly from the chart. Click the  button and then the 

 button.
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The higher you set 
the pattern match 
option in in the 
Pattern Editor, the 
closer the price 
movement must be 
to match the 
pattern.
Forecaster now recognizes the pattern on the KO chart. 

In this example, it is recognized 30 times on the medium setting.

Choose the Forecast Cloud tab to see the most current Forecast Cloud.

This example shows that after this price pattern occurs that price tends to rise 
about 10% over 45 days. So if you traded this, it would make sense to target a max 
price at 10% above the current price and set a stop at the cloud bottom.
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Switch back to the Price, Volume, and Event Markers to see the current forecast 
cloud for the event. After choosing the tab, select the latest event.

Below is an example of a previous opportunity using the same pattern on KO. 
Notice the strong following of price in the probability cloud.

Price Patterns are powerful, and using them in the Forecaster is especially 
powerful. Understanding the direction of price after a pattern can give us as 
traders a better understanding of the recurring movements of price after a price 
pattern. Using this in trading is a targeted way to help you in your trades.

See the related video at www.metastock.com/upm
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If you have a chart 
open, right-click on
the chart, select 
apply template and
choose RMO TRADE
MODEL.MWT.
C H A P T E R  9 U N D E R S TA N D I N G  T H E  RMO

About the RMO
The Rahul Mohindar Oscillator (RMO) and its associated MetaStock tools were 
developed by Mr. Rahul Mohindar of Viratech Software (viratechsoftware.com). In 
addition to being a trader and a trainer, Mr. Mohindar is a panelist on both CNBC 
and CNN India. 

The RMO can be used across any timeframe and for any instrument. It is designed 
to work with data that provides Open/High/Low/Close. To apply the RMO to a 
chart:

Click  to open the Power Console.

Select  in the Power Console.

Enter Symbol and Choose RMO Trade Model from the Apply template option in 
the Attachment section of the chart dialogue
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Click .

Your chart then opens with the RMO Trade Model template applied.

The RMO is a rule-based system that requires multiple criteria to allow for entry or 
exit confirmation. The rules of the system are set up to allow the RMO user to 
manage their trades quickly. The first set of rules applies to both position and real-
time traders. At the end, there is an additional step for real-time traders. Make sure, 
no matter what type of trader you are to follow the first set of rules. 
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Item Item Name Description

First window Rahul Mohindar Oscillator

Second win-
dow

Swing Trade 2 and Swing Trade 3

Third window Exit Swing Indicator

Fourth win-
dow

Price bars with color and entry/exit signals

Fifth window Volume with moving average
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Always follow the 
first set of rules for 
the RMO, no matter 
what kind of trader 
you are.
Note: The first new 
set up is typically 
the strongest.
Rules of the RMO
1. The first thing to review with the RMO is the green RMO Oscillator, found in the 

top window. This indicator is our first gauge as to market direction. It is set up 
to be our primary trend indicator.   Notice on the RMO, the scale to the right of 
the indicator has a mid-point of zero. That is the main reference point of the 
RMO. For a bullish trigger we want the RMO to be above zero and for bearish 
we want the RMO to be below zero. Once we have determined our primary 
trend, we can move to the next window. 

2. The second window contains SwingTrd2, which is pink (Swing Trade 2) and 
SwingTrd3, which is purple (Swing Trade 3). These two indicators are designed 
to help us see the medium-term and long-term trends. SwingTrd2 represents 
the medium-term trend, and SwingTrd3 represents the long-term trend. When 
SwingTrd2 and SwingTrd3 cross, it represents a change in the strength of the 
trend. 
For the moment, let's move past the Exit Swing indicator and move to the 
fourth window containing the price bars.

3. The color of the price bars and the buy and sell alerts are directly tied to the 
SwingTrd2 and SwingTrd3 indicators. In rule 2, we discussed that when Swing-
Trd2 and SwingTrd3 cross, we have a change in strength. The red and blue 
arrows shown in the 4th window represent that strength change. The color of 
the bars changes from blue to red when SwingTrd2 moves above or below its 
zero line. The blue bars represent bullish, and the red bars represent bearish. 

To identify 
trading 
opportunities

Step Action

1 To find a trade the following must be in alignment:
a. Bullish or Long Trade

i. RMO above zero
ii. Most recent alert arrow must be blue
iii.Price bars are blue
iv.It is important to note that these three criteria do 

not need to happen on the same bar
b. Bearish or Short Trade

i. RMO below Zero
ii. Most recent alert arrow must be red
iii.Price bars are red
iv.It is important to note that these three criteria do 

not need to happen on the same bar
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2 It is recommended that you make a trade when the 
three rules align. 

These rules are set up to allow the user to 
actively monitor the trade. To exit a trade, 
look for the opposite criteria. For example, if 
you are in a long trade and the RMO is above 
0, the last bar is blue, and the price bars are 
blue, then look for the RMO to be below 
zero, the last arrow is red, and price bars are  
red to exit the trade. 

3 Follow the rules to set stops.

Mr. Mohindar designed the system with the 
trader in mind and as such, designed the 
system with rules for a trader to set stops. 
a. Place your stop a couple of ticks below the previous bar 

low.
b. If the current bar is lower, place your stop a couple of 

ticks below the current bar.
c. If you are in a long position, move the stop up with 

each new buy alert. (This may also be an opportunity to 
add to your position.)

4 Apply these rules to the indicator in order to use it as 
designed.

The exit swing indicator gives you extra pro-
tection in applying stops. 
a. Don't use this indicator unless you are in a profitable 

position.
b. The exit swing indicator has two horizontal lines. The 

top line is red, and the bottom is blue. If you are in a 
long position and the exit swing indicator falls below 
the red line, consider putting in a trailing stop.

c. Likewise, if the exit swing indicator crosses above the 
blue line and you are in a short position, consider 
putting in a trailing stop. 

Step Action

If you are in a short 
trade, place your 
stop a couple of ticks 
above the previous 
bar high.

You can also ladder 
your position by 
adding to a trade 
with each new blue 
arrow if going long. 
This would be at the 
same time you are 
moving up your 
stop.
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The Explorer allows
you to choose 
multiple criteria by 
using the CRTL key 
and selecting the 
explorations you 
wish to use. Mix 
and match as 
many criteria as 
you would like.
RMO Explorations
The following explorations match the rules of the RMO that we have just learned, 
however, the terminology is a little different. Let's work through the rules and 
understand what each exploration does. 

These explorations can be used in any combination to identify trading 
opportunities. You can use one of the explorations by itself or combine multiple 
explorations. The best way is to use combinations of the bullish explorations (RMO 
Bullish Zone, RMO Market Trend New BLUE, and SwingTrd Buy Arrow) or the 
Bearish explorations (RMO Bearish Zone, RMO Market Trend New RED, and 
SwingTrd Sell Arrow) to identify opportunities. This example uses a combination 
of the three bullish explorations. To select more than one exploration, use the CTRL 
button and select the three bullish explorations. 

Explore for opportunities using the RMO
Now that you understand the rules of the RMO, you can use the functions built into 
The Explorer in MetaStock. The Explorer has six explorations that match the rules of 
the RMO.

Click  to open the Power Console.

Select  in the Power Console.

 Name Description

RMO Bearish Zone This exploration looks for instruments that have the RMO in 
a current bearish state, meaning the RMO is below zero.

RMO Bullish Zone This exploration looks for instruments that have the RMO in 
a current bullish state, meaning the RMO is above zero.

RMO Market Trend 
New BLUE

This exploration looks for instruments that have a new blue 
bar as the most current bar.

RMO Market Trend 
New RED

This exploration looks for instruments that have a new red 
bar as the most current bar.

SwingTrd Buy Arrow This exploration looks for instruments in which the most 
recent bar has a buy arrow.

SwingTrd Sell Arrow This exploration looks for instruments in which the most 
recent bar has a sell arrow.
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Scroll down and select the three bullish RMO Explorations and the desired list to 
scan.

Makes sure to select the "Use the results from the preceding exploration". This 
option uses our single chosen list of instruments to filter through all three criteria.

See the related video at www.metastock.com/upm
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Bonus Features in MetaStock 17
This chapter discusses some of the new features inside MetaStock 17. We covered 
the QuoteCenter and OptionScope in "MetaStock Power Tools Overview" on 
page 20. Please refer to that chapter for help on those features. This chapter covers 
some of the other beneficial additions which may help users on a day to day basis. 
These features are presented in no particular order and may only benefit one 
version of MetaStock. We note such cases along with the feature.

Feature 1 - Pre/Post Market Data - MetaStock R/T only
Pre/Post market data allows you to be able to view the market data that happens 
before the official market open and after the official market close. Some exchanges 
offer the ability to chart/view this data. It may be beneficial as the market draws to 
an open or close to see a pending upcoming move at market open or with after 
market news. 

In the image below is a chart of Ford (F) in a 5-minute chart.
Unleash the Power of MetaStock 17 115



Chapter 10: New Features
Now let’s look at the same chart with pre/post-market turned on. To do this, we are 
going to duplicate the current window and view the charts side-by-side. To do this 
go to Window | New Window.

After this, we want to view them side-by-side, so select the column icon in the 
Standard Toolbar.

We now have the two images side-by-side.
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To turn pre/post-market data on in one chart right click on the white space of a 
chart and the go to Chart Window Properties.
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Next, select the Trading Sessions Tab and then Select Include Pre and Post Market 
then choose OK.

Now the two charts look very different. The one on the left is the standard market, 
and the right includes pre/post-market data.

Feature 2 - Clear Smart Charts
Smart Charts in MetaStock are a powerful feature that allows you to make changes 
to a standard chart and have MetaStock automatically save your notes, indicators, 
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applied experts, and line studies. Then the chart can be closed, and MetaStock still 
remembers where you left off. While this feature is great, from time to time, users 
like to clear their charts and start fresh. MetaStock 17 has made this very simple. To 
clear your Smart Charts, go to File | Delete Smart Charts (Please note it is best to 
have all your charts closed before doing this).

MetaStock displays a warning explaining what it is about to deleted if you proceed.

Once you choose Yes, MetaStock clears your Smart Charts.

Feature 3 - Back up your user files
From time to time, everyone feels the need to make sure everything is backed up. 
That is why MetaStock 17 includes the feature to be able to back up all your files.  
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To back-up your files, go to File | Back Up User Files

MetaStock then asks where to save the user files. It defaults to the MetaStock 
Folder. You can change this, but the MetaStock folder is the preferred location.

Choose Select Folder to finish backing up your user files. If you want to restore a 
user file, it is recommended to call support.

Feature 4 - Easier access to reports
We’ve made it easier to access previous reports from Explorations and System 
Tests. This example shows the Explorer, but the process would be the same on the 
System Test tab. 
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Click on  in the Power Console. An “<R>” denotes any explorations you 
ran previously.

Now to access all reports, you can choose the Report button in the Explorer Tab or 
System Test Tab.

Once that is selected, MetaStock presents you with the option to view all reports or 
selected reports. In this example, there are none selected, so the only option 
presented is the option to view all reports.
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It then displays all previously run explorations. 

Remember this option is also available on the System Test tab. 

Feature 5 - Create a Watchlist of Options. 

This workflow assumes that you’ve followed the instructions included the 
introduction to the Power Tools and have the ability to open OptionScope. If you 
did not, please refer back to those instructions. 

Here you can view a narrowed down view of options in the OptionScope product.

Here we are going to create a watchlist of these options in MetaStock. To do this, 
highlight the Calls/Puts that you want to select.
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To select, highlight the first one and then drag down while holding CTRL.

After highlighting these, right-click and select Copy to Clipboard.
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Return to MetaStock and go to the Power Console. From anywhere in the Power 
Console choose Custom List.

When the Custom List manager is displayed, choose New | Online Instruments

Give the list a name. In this example used My Options.
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After that, right-click in the white space and choose Paste.

That inserts the symbols into the custom list manager. After they appear, click save. 
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From here these symbols are now included in your custom lists in the Power 
Console. You can use this list to Chart/Scan/Back Test/ or even Forecast! 
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Creating a new List
MetaStock XV added the advantage of allowing a user to be able to read several 
different local data formats. It can read MetaStock Legacy File Format, CSV, or our 
new and improved local data format called MSLocal.   Local data gives a user the 
flexibility to work with MetaStock Offline or use data that resides on your computer 
to chart, scan, test, or forecast. So all of the workflows covered in chapters that 
cover these tools can be done using local data. 

This chapter covers how to add local data files to your MetaStock so you can use 
them in your workflows. It does not cover how to create or manage your local data 
files. Refer to the MetaStock help or other resources on how to create and maintain 
your local data files. 

To add existing local data files to MetaStock:

Click  to open the Power Console.

Select  to open the Chart tab.

To add local data files right click on the word Instruments in the Instrument Tree. 
The option to manage Public Lists or Custom List is displayed.

Select the option to Manage Custom Lists. 
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Chapter 11: Working with Local Data
The custom list manager is displayed.

In the custom list manager select the  button and select Local 
Instruments.
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Chapter 11: Working with Local Data
This takes you to the New Custom List dialogue box.
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Chapter 11: Working with Local Data
Adding Instruments to the List
It is effortless to add a full folder of securities to your folder. Start by selecting the 

 button.

The Local Instruments box is displayed.
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Chapter 11: Working with Local Data
From here we need to what folder is to be added into the local data library. In the 
Local Instruments box, select .

At this point, you need to navigate to the folder that holds your data. As that may 
be different for each user, we use a generic example.   Navigate to the folder that 
contains your data.
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Chapter 11: Working with Local Data
This example selects the “MYData” folder. Select the folder you want to load and 
then choose the  button.

All the compatible data files in that folder are selected.
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Chapter 11: Working with Local Data
Here is what each column means.

Item Description

The interval of the data. You may see D for Daily. W – 
Weekly Q- Quarterly Y Yearly. (other intervals are available 
for R/T)

The ticker symbol of the instrument 

Name of the instrument

Type of file format. MSLocal is the new file format, CSV or 
Legacy (Original MetaStock File Format)
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Chapter 11: Working with Local Data
Note that all the files are now selected automatically (denoted by a gray or blue 
color). To add to the list, select the  button.
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Chapter 11: Working with Local Data
Saving the New List
The files are loaded into the custom list. MetaStock automatically uses the folder 
name for the list name. There is no need to create a new folder name. 
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Chapter 11: Working with Local Data
Select .

The folder now shows in the Custom List Manager.
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Chapter 11: Working with Local Data
Repeat this process for all folders that you want to load into MetaStock. If you have 
finished loading lists, choose .

The list of instruments is now available in the Power Console.

Now that the Power Console includes the list, you can use it for any workflow. You 
can Open Charts, Explore, Test, and Forecast from this list.

See the related video at www.metastock.com/upm
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	Chapter 2 Starting with MetaStock
	When opened, MetaStock presents you with a box called the Power Console.
	The Power Console is the heart of MetaStock and is designed to allow you quick access to Chart, Explore, Manage and View lists, Back Test, view and analyze options or Forecast. This manual covers all of these and shows you how to use them in MetaStoc...
	Opening a chart
	Choose the in the Power Console. The button turns orange when selected. This button gives you access the charting functionality inside the Power Console.
	The first way to open a chart is by typing a symbol directly. If you know the symbol, click on the Instrument(s) line of the dialog box.
	From here, you simply enter your Instrument, and you are then ready to open a chart. If you do not know the symbol, you can choose the Instrument Search button. That gives you a dialogue which lets you search for instruments based on what you know of...
	For example, select the Name radial button and Starts with. Then type in FORD. The box narrows down to a set of symbols that match that criteria.
	Select any of the instruments by double-clicking, and it populates automatically in the Instrument(s) dialogue.
	At this point, you can open the chart; however, there are other ways that instruments can be selected. The Instrument Tree is found directly under the Select Instrument(s) box.
	The list of securities is the full universe of instruments that are available depending on your data subscription. Note that the list in the above image shows 292,818. To see all the symbols available, you can select the arrow next to the box showing...
	You can continue to select arrows and narrow down what you want to review. However, as a trader, your focus is probably only one or two markets. So lets review having MetaStock only show the symbols for a few markets. To do this right-click on the wo...
	Select the option Manage Public Lists, and the Public List Editor appears. This dialog allows you to see only the lists that pertain to what you want to track rather than the entire global list. The left window shows the Available Lists. The right wi...
	This example shall select the US and Canadian Instruments. Scroll the list down to find exchanges to include in your Power Console. You can select multiple lists at a time by selecting the first in the list you want. Then hold the shift button on you...
	Choose the button. That moves the selected lists over. The right window must include at least one header, such as: Equities - North America.
	There are several options to choose from, including global stock lists, global futures, and indices. There are also lists for Index Constituents. Once your list is customized, You can move the entries up and down. You can also create a custom header ...
	Once you have defined the lists: Choose the button and your list shall only show what you selected in the Public List Editor.
	To view the lists in the Power Console, choose the arrow next to the Public Online Data lists (notice in the list that the number of instruments has decreased due to the reduced selection of lists). You can also expand each section to a granular view...
	Now that the lists appear as we want to see them, it is time to open a chart. For this example, we shall use .DJI to open the chart. When you enter text in the Select Instrument dialog box, the Instrument Tree becomes grayed out.
	There are three sections to choose defaults or settings for once you open your chart.
	After setting your selections, choose .
	Many options become available once the chart opens.

	Chart Styles and Options
	MetaStock provides nine charting styles (price styles) when viewing pricing information:
	The price plot is the data displayed on the chart by the instrument's price information. You can change many aspects of the price plot's appearance, including style (e.g., Line, Bar or Candlestick), color, and line thickness.
	To modify the properties of a chart, open the chart to be changed. Either select Format > Prices or right-click on the price plot and select <instrument name> Properties. The instrument’s Properties dialog then opens.
	Select the price style, color, or line weight you wish to use. Click to close the window.

	Editing Charts
	Zooming
	Sometimes you want to see a small section of a chart up close. There are many ways to change the zoom level:
	Default Template

	The Default Template allows you to set a newly opened chart to a predefined look. This way, you can have the same set of indicators or color schemes apply to all of the charts you open automatically. The default template is a template that is exactly...
	To quickly make the information in the currently selected chart the default template, right-click on the chart and choose Save as default template.
	Chart Windows

	MetaStock displays each chart in a separate window. There are several commands to control how those windows are displayed. Tile and Cascade are common to most Windows applications. Stack, Column, and Automatically Tile are unique to MetaStock. These ...

	Indicators
	An indicator is simply a mathematical calculation applied to some or all of the price fields and/or volume. Indicators can be plotted in the chart to show a graphical representation of these calculations.
	To learn more about inserting and applying indicators refer to the Getting Started with MetaStock manual.
	There are two ways of plotting an indicator in MetaStock. You can choose Insert > Indicators to display and use the Indicators dialog. You can also drag and drop an indicator from the Quicklist.
	The Indicator Quicklist (located on the standard toolbar) provides quick access to all the indicators in MetaStock. It also moves to the top, the 20 most recently used indicators for easier access. You can drag indicators from the list by holding dow...
	A quick way to get to the desired indicator in the Indicator QuickList is to display the Indicator QuickList and then type the first letter of the indicator's name. The list quickly advances down to the indicators beginning with that letter.
	After you have plotted an indicator, you can modify any of its properties (for example, color or number of periods) with the indicator's properties dialog. Right- click directly on the plotted indicator and choose Properties on the shortcut menu.
	The properties dialog opens, allowing you to edit the properties of the indicator. Choose any of the tabs and make your desired changes. Click to close the dialog.
	You can also open the indicator properties dialog by double-clicking directly on the plotted indicator or by selecting the indicator and then choosing Format > Selected Object.

	Line Studies
	Line studies are one of the most popular tools in MetaStock. They help you see trends and patterns in a chart, which can give you an edge when making trading decisions. Every line study contains its own set of parameters you can access by right-click...
	Line studies are drawn on a chart by either choosing the line study from the Insert menu or by selecting the desired icon on the appropriate drawing toolbar. There are several toolbars with line studies on them. You can cycle through them by clicking...
	Line studies are attached to the plot closest to the mouse pointer when you first click to begin drawing.
	You can delete a line study by:


	Chapter 3 MetaStock Power Tools Overview
	The MetaStock Power Tools help you avoid spending time analyzing charts one by one. With them, you can quickly: identify opportunities by scanning through the market; backtest your strategies; understand the direction of price; and get Buy and Sell s...
	The Expert Advisor™
	The Expert Advisor is a collection of trading strategies which, when attached to a chart, can help keep you informed on the current technical state of a chart. It does this by using underlying indicators to generate the buy and sell signals on your c...
	To attach an expert advisor, you can select it from the Power Console before you open a chart by selecting the expert under the Attachment section of the Open Chart Dialog.
	There are multiple ways you can access the Expert Advisor once a chart is open. You can select the Expert Advisor from the Standard Tool Bar by choosing the Expert Advisor icon.
	Going to Tools > Expert Advisor
	Or Right-clicking on chart and choosing Expert Advisor, then Attach....
	Once you open the Expert Advisor dialog, select the expert to attach.
	Select . The expert then plots on your chart. Below is an example of the Dow Jones Industrial Average (.DJI) with the MACD by MetaStock Expert attached.
	To open the Expert Commentary window, for a walkthrough of the signals on the chart, choose View > Expert Commentary. That displays the Expert Commentary window on your chart.

	The Explorer™
	The Explorer is a powerful multi-purpose analysis tool that can perform in-depth "explorations" on multiple instruments.
	The Explorer lets you perform many specialized tasks, including:
	You can use the Explorer to discover which instruments:
	You can use the Explorer to generate:
	Access the Explorer by choosing from the Power Console or by choosing the Explorer icon from the Standard Tool Bar.
	Once you have selected the Explorer icon, the Power Console presents two boxes. One is to choose the exploration (technical criteria), and the other is to choose the set of instruments.
	Notice that MetaStock comes with hundreds of explorations. To avoid looking through the full list, you can add the explorations you use frequently to the exploration Favorites. Choose the arrow next to the exploration tree and right-click on CandleSt...
	The CandleStick Bearish Patterns exploration is now in the Favorites section. Notice it still appears in the main list.
	You can remove explorations from favorites by right-clicking on them and selecting Remove from Favorites. This action does not delete the exploration or its report. The exploration is only removed from the Favorites section and is still in the full l...
	For this example, select the MACD Buy Signal. Then expand the Instrument List and select the S&P 100.
	Once the Exploration and the list are selected, then there are other selections to be made:
	After making all selections, click the to begin your exploration. Once the exploration begins, MetaStock displays a window showing the exploration status.
	When the exploration finishes, MetaStock displays the report in the bottom part of the window.
	This report shows an example of the instruments that meet the criteria selected.
	To open a chart from here, you can either select and highlight an instrument(s) and choose ; or you can double-click on any instrument. Either method opens the chart(s) for you. You can leave the Explorer dialogue open while you work with charts. You...

	The System Tester™
	System testing involves the development and testing of trading systems to determine the systems' historical profitability. System testing helps answer the question, "If I had traded this instrument using these trading rules, how much money would I ha...
	You can also test your trading ideas with the System Tester. Including the following:
	To access the System Tester choose the from the Power Console or by choosing the System Test icon from the standard toolbar
	or by choosing Tools > System Tester.
	The System Tester options are all located on one screen for you to set your testing conditions. This section gives a brief overview. For more detail, see "Filtering and Backtesting" on page 54 and "More on Backtesting" on page 65.
	Once you have selected the System Test icon, MetaStock displays two boxes. One is to choose the System Test (technical criteria), and the other is to choose the set of instruments.
	As with explorations, MetaStock comes with a large number of system tests. Similarly, you can right-click on a system test and add it to a favorites list.
	Choose the arrow next to the System Test and select the system to be used. This example uses the MACD Expert System test. To select instrument(s), either enter a specific security in the enter Instrument(s) box or select multiple instruments from the...
	The next step is to set the testing options.
	Begin the System test by choosing the button.
	The System Tester simulation completed dialogue appears when the test finishes.
	Choose the button to view the system test results. That shows the results of the system test.
	The tabs and results show the overall results of the test:
	To review the sections and all the categories click on the button in the top right-hand corner. That explain the tabs and all the information contained in the results. "More on Backtesting" on page 65 includes how to reference the top sections of dat...

	The MetaStock Forecaster™
	Forecasting is a science that allows us to look at how price behaves after an event has occurred. An event can be anything from a Moving Average Crossover to a single day Candlestick pattern. The ranges of events can be varied; however, our main conc...
	The Forecaster allows you to:
	Example Forecast Cloud:
	To access the Forecaster choose from the Power Console or by choosing the Forecaster icon from the standard toolbar
	or by choosing Tools > Forecaster. The Forecaster can also be launched from any active chart by right-clicking and choosing Forecaster.
	Choose which Instrument to open by either selecting the Instrument(s) dialogue box or from the Instrument(s) tree.
	This example uses .SPX.
	Selections for forecast use the following.
	Once the Forecaster is launched, it opens as a new, separate charting application. An example of the Forecaster window appears as below.
	The Forecaster shows a chart with yellow triangle arrows above and below the price chart. These are not indicative of buy and sell arrows, but show when an "event" occurred. The event can define a technical set up or when the signal occurred. Do not ...
	Below the chart is the list of recognized events with options for sorting.
	After you chose an event, the Forecaster gives a Statistical Report. It also shows Event Dates under the events date tab.
	The probability scale allows you to select the probabilities you want to view. You control that by moving the scale from low to high.
	Selecting the Forecast Cloud tab displays the current forecast cloud for the selected event.
	"Using the Forecaster" on page 74 includes more detail on how to use the cloud.

	QuoteCenter
	QuoteCenter is a multi-function tool to see the current status of the securities in which you are interested. You can view your pick list, your positions, your indices, or any other list you choose. More than that, you can easily build and set up lis...
	Sort on a variety of criteria to view the data important to you, then double click on a security if you want to see a chart. It’s a fast and easy way to make your workflow more efficient than ever. You can even change the color theme.
	Depending on the version of MetaStock you have depends on the type of data you can see. MetaStock R/T customers have the option to view data in real-time.* MetaStock D/C customers can work with online data from Datalink or use your offline data in Me...
	You can access QuoteCenter by choosing from within the Power Console or by choosing the QuoteCenter icon from the Standard Tool Bar.
	From here, you can easily select lists to work with or build a custom list to use instead. This section covers how to build a list or use a prebuilt list. We shall first open a list using a prebuilt one included in MetaStock.
	Once you select the QuoteCenter icon, the Power Console presents you with your lists. If you followed the instructions in the previous chapter and narrowed down your lists to markets you follow, only those lists appear; otherwise the global lists app...
	This example uses the S&P 500 list. Select the box next to this list, and the next pane then displays the symbol list of the S&P 500.
	If you want to open this list as is, choose . However, before we proceed to open the list, let’s review what to do if you want to make changes to the list. If you select any of the instruments in the Selected Instruments dialogue, they become highl...
	Deleted those instruments reduces the size of the S&P 500 list.
	With our list customized, choose . This launchs QuoteCenter.
	Different versions of MetaStock use different headers in QuoteCenter. For example, instead of "Time" in R/T, D/C shows "Data" in D/C. D/C also does not provide Bid/ Ask data. The source column tells you if you are looking at data that is online or of...
	Any of the column headers that you see are also sortable. You can click to sort ascending and double click to sort descending. This image shows volume sorted in descending order. Note: Volume shows a down arrow denoting descending order:
	If you wish to add to the list of securities you can enter the symbol into the Add Instruments box.
	And then choose Add.
	This adds the new instrument(s) to your list and bolds it.
	When your list is displayed, you can use QuoteCenter to open charts and have them displayed in MetaStock. Do this by double-clicking anywhere that contains data on the symbol you want to open. That action displays the line item that you’ve double-c...
	Each chart you open appears in MetaStock. You can also open multiple charts at a time by holding shift and selecting a group of stocks, or CTRL + Click to highlight multiple instruments.
	Alternatively, you could delete the selected items by choosing the delete option.
	Once you are done working with your list, you can either discard your changes or save them. If you do not want to save your changes, close QuoteCenter and then say no when asked to save. The rest of this section explains how to save your list.
	QuoteCenter gives a list a temporary name called "QuoteCenter List 1" (or assign another temporary number). If it assigns another number than 1 that means it already saved a list 1. You can use the QuoteCenter naming by clicking save, or you can give...
	You would then give your list a name and choose save.
	After you save a list, you can exit out of the QuoteCenter App without losing it. If we want to use it again, we can return to the Power Console and view it under the QuoteCenter Tab.
	You can open the list from here, or you can go to the Use Existing List tab. Highlight the list and click . All the custom lists you have created show up under “Use Existing List.”

	OptionScope
	OptionScope puts all critical info at your fingertips. The OptionScope option chain display gives you sortable, customizable, color-coded options data – including the greeks.
	The OptionScope filter window makes honing in on the data you want to see a breeze. Of course, MetaStock’s legendary charts are just a click away, saving you time and effort.
	Choose in the Power Console.
	Alternatively, you can choose the OptionScope button from the Standard Toolbar.
	You can also open OptionScope for any open chart by right-clicking on an open chart and choosing OptionScope.
	Selecting to open OptionScope from the Power Console gives the most flexibility, allowing you to filter the data before OptionScope opens. The workflow presented here will cover opening from the Power Console. You can analyze one security at a time i...
	Before we select to open OptionScope, you can narrow down the results of what you choose to see if you prefer. For this workflow, select Options that expire in the next 90 days, is within 15% of the strike price, and all expiration types. More select...
	MetaStock presents you with a grid view of OptionScope.
	On the left side, OptionScope shows Filters in which you can further narrow down the options you want to view. You can expand any of the Filters by selecting the down arrow next to each Filter Type.
	You can also note that each filter that OptionScope highlights in black each filter that you applied. In this case, you can see the same filters selected in the Power Console are applied.
	You can change the filters by simply selecting any filter you choose, or you can reset by selecting the clear all filters.
	OptionScope displays the data In the Grid Section with Calls on the left and Puts on the right. Expiration Date of the Option and Strike Price appear in the middle. Rows colored blue indicate that option is In the Money. Out of the Money options appe...
	You can see by applying different filters that you can narrow down the data that appears.
	Once you’ve narrowed down the filters and want to be more specific, it is possible to double click on any of the options listed, and MetaStock opens a chart of the specific option. The example below selects two options and shows the accompanying ch...
	For help with how to use any of the columns you can refer to the help in OptionScope.

	Indicator Builder™
	The Indicator Builder is a tool that allows you to build and design custom indicators. MetaStock comes prebuilt with a large collection of tools that are ready to use; however, you have the ability to custom design your own indicator sets. To learn m...
	See the related video at www.metastock.com/upm

	Downloader
	Downloader is a program designed to help you manage local data. With MetaStock XV and higher, you can read data files that are stored locally on your computer. The Downloader program collects and stores that data. Downloader uses Datalink™ to save ...


	Chapter 4 Filtering and Backtesting
	Why Filter and Backtest?
	A sound approach to finding tradable stocks (or any asset type) with MetaStock is using a simple three-step approach:
	This workflow allows you to take your instruments (stocks, futures, or FOREX) and narrow them down to the instruments that meet your criteria. You can start with a custom list of your favorite instruments, a common list like the Nasdaq 100, or any wo...
	Once you have identified the instruments that meet your criteria, you can backtest the stocks to see how the trades performed. This process gives better insight into which ones may work best.

	Filtering Instruments
	Access the Explorer by choosing from the Power Console or by choosing the Explorer icon from the Standard Tool Bar.
	Once you have selected the Explorer icon, MetaStock presents two boxes. One is to choose the exploration (technical criteria), and the other is to choose the set of instruments.
	Choose the arrow next to each tree to expand and select the exploration and the list. This example selects the MACD Buy Signal and the S&P 500.
	Choose . Once the exploration starts; a window opens showing the exploration status.
	When the exploration finishes, the report is displayed in the lower half of the window.
	This image shows an example of the instruments that meet the criteria selected. Depending on the number of results, it may be difficult to decide which instrument to trade. The System Tester can help us to determine which instruments to trade.

	Backtesting Instruments
	To System Test the results of the Exploration, close the Exploration Results, return to the Power Console and choose the System Test icon.
	In the System Test tree, select the system to match the exploration. In this case, select the MACD Expert System, and in the Instrument Tree, select the Last Exploration Results List (Hint: This list always shows the results of the last exploration).
	For the options, since we scanned a buy signal, let's perform the test on Long Trades only. The Range can be variable. The default is for the last 250 records or one year of daily data. For this example, change the range to 500 records, or two years ...
	Choose Trade Options.
	Click on the Account tab. Here set the Initial Equity to the amount you having in your trading account, then change the Default Size to Percent of Available Equity. Under this category, choose the amount you are willing to risk in the trade. In this ...
	Select the Broker tab
	Here the commission tab allows setting the cost of the trades for a more realistic result. This option can be left blank if the user chooses to test this way. For this example, set the commissions as $7 to enter a trade and $7 to exit.
	For the person new to MetaStock and System Testing it is recommended to leave the Reporting and Trade Execution tabs as the defaults.
	Close the System Test Options page by selecting the button. In the Power Console, select the Button.
	Once the System Test is complete, an option to view System Test results is displayed.
	Select the Button.
	The results are now displayed.
	The Test View opens. The graph at the top shows the average net profit.
	The bottom grid gives quite a bit of information.
	The columns tell us a few bits of important information.
	Any of these results can be selected to rank based on that criteria. Double click any header to sort on that criteria. In the example below the net profit has been double-clicked to sort on that header. Now the Instrument with best trading success ha...
	Before going into more detail, there is much to learn in the Test View screen. One main question is does this fits your individual risk and trading style. This test ran over 500 days (2 years). Looking at the first instrument, note that it traded 54 ...
	To get more detail, choose an instrument by double-clicking the instrument name.
	The overview page gives specific details on the trades. The information provided includes Highest Profit/Lowest Profit, Trade Timing, Out of market, and others. The accounting section shows the change in the account, including Trade Profit/Trade Loss...
	The best way to quickly identify if a system has traded well over time is to review the Equity tab. Select the Equity Tab. The top section shows the Equity Line (or money over time).
	When looking at an equity line, it is important to look for growth over time without major drawdown (loss in funds). The Equity line above shows this type of growth except for the period between 280-350. The growth has flattened the last 50 bars. Tha...
	Looking for strong, steady equity lines is critical to finding a good system as it shows consistent trades over time. This example is a good example as the most recent trades have been the best trades.
	Open the Chart and apply the corresponding expert to follow the trend.
	See the related video at www.metastock.com/upm


	Chapter 5 More on Backtesting
	It is no secret that everything trades a little differently. It can be difficult to match the personality of a system to the personality of the instrument that you are trading. For example, Apple may trade very differently from Bank of America. The E...
	Performing a Multi-System Test
	This example tests WalMart against the Performance Systems included in MetaStock. You can apply this workflow to any instrument; this is just one example of how multiple system testing works. This work flow takes 1 instrument against 26 strategies to...
	Click to open the Power Console.
	Select in the Power Console
	In the Power Console, select the 26 System Tests that begin with PS (Performance Systems) and the Instrument Dialog Box enter in WMT (or the instrument you want to test). Hint: When selecting multiple systems, you can select the first system in a ran...
	Once the instrument and the systems are selected, the Trade options need to be selected.
	When running the test, you usually set the parameters to your personal trading preferences. For this example, set the trades as Both. That tells the System Test to trade both long and short. Set the Range to 500 records (or two years on a daily bar)....
	Select the button.
	Select the Account Tab:
	For this example, set the Initial Equity to 10000 and set the Percent of Available Equity to 30%. That tells the system to trade 30% of whatever funds are available in the account. This amount can vary depending on if the account drops to 50000 or in...
	Select the Broker Tab
	For this example, use Points per Transaction. This setting denotes how much it costs to enter a trade and how much to exit a trade (commission). Set this to the amount that you pay to place your trades.
	Select .
	Begin the system test by selecting the button.
	When the test is completed choose the button to review the results of the test.

	Reading the Report
	Below is the System Tester - Test View screen for the test we just ran. It shows an overview of all the systems used in the test.
	The Columns represent the following:.
	To sort on columns double click on the headers. For this example, double-click on % Gain. The report then shows the top results based on % Gain.
	By looking at this screen, we can already see systems that we would not likely trade (those in the negative). That shows we have a few strategies that seem to match the personality of Walmart. Double-click on a test result to review the specific deta...
	The summary page gives an overview of how the trades have performed over time.
	The critical test for this will to be to review the Equity line. The Equity line shows how the instrument has performed. Select the Equity tab after reviewing the Summary Tab.
	Think of the Equity line as a trend line. This example shows a consistent movement in the upward direction.
	Using the Equity Line as a gauge of the trades, you can quickly identify those that don't work. Consider an Equity Line that appears as below.
	The movement is up overall but with a lot of movement up and down. That shows whipsaw in the trading and inconsistent trades. That is not the type of movement we want in our trades.
	Looking at several inconsistent trading results shows the importance of looking for a smooth, consistent Equity line.
	Once you decide on a system, go back, open the chart, and apply the appropriate Expert Adviser. The Expert can help guide you through the chart and signals available.
	See the related video at www.metastock.com/upm


	Chapter 6 Using the Forecaster
	As traders, we can see where the price has been and what the patterns look like on a chart. However, the biggest question we always ask is, "Where is the price going to go next?". That question is critical to a trader, and the MetaStock Forecaster ca...
	The way the Forecaster looks at a chart is to analyze the event happening. Meaning that when doing analysis, you aren't looking at buy and sell signals, you are only looking at when a technical set up occurs. For example. Below is a chart that shows ...
	The Forecaster analyzes each of the events and shows what happened to the price after the events. It expresses that in the form of a probability cloud.
	This example is showing what the BK does after a MACD Cross up (or buy signal) occurs. The price shows a short term flat period before moving down. So if you are trading the MACD on the BK, it tends to have a slight increase before a pullback. Inform...
	Opening a Forecast Analysis
	Open a Forecast chart:
	Click to open the Power Console
	Choose the Forecaster Tab .
	In the Power Console either select from the Instrument Tree or type in to the Instrument(s) selection box. For this example BK will be used.
	After selecting the instrument, start the Forecaster by clicking the button.
	The Forecaster application launches.
	The Forecaster opens and defaults to a screen that shows relevant recognized events. From this screen, we can choose recognized events, view statistical reports, and view the forecast cloud.
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	Probability Clouds
	To begin the workflow:
	Choose the Forecast Cloud tab
	The Forecaster then displays a cloud.
	Note in the cloud that it says Past Performance in the box. The past performance means that it is showing a probability cloud. What price has done historically, based on the event, determines the cloud. This event is 52 Weekly High.
	First the cloud will be reviewed.
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	The recognized events screen allows a user to choose from different events. Each event is it's own technical set up. The checkmark next to the event means that the event is viable for review. If you see an exclamation mark, it means that there were e...
	Choose a different event by selecting the name of the event, and the cloud focus then changes based on the event selected. For example, choose the sorted by criteria Most Accurate Current Forecast. The display changes in this example as the top crite...
	Finally, the statistical report shows the report of the event. There are three tabs. The Statistical Report shows an overview of the signals and their statistical relevance. The second tab Event Locations shows when that the event(s) occurred. The Er...
	The cloud tells a story to help us understand how we should be managing our money with the trade. The new cloud is one with more statistical relevance. To understand why we look at the cloud. Let's examine this display in more detail.
	The bright colors that display on the chart show that there is a higher probability of prices moving in that direction. Using the probability scale on the right side of the chart it can be noted that the bright colors of red and yellow show the highe...
	This chart shows that after a 5 Days or More Up Signal, prices tend to stay with a range up/down of 5% over the 1-14 days. After those 14 days, it then probably makes a move upwards of 10% with -2% on the low end. Since you are a trader, how would yo...
	Another way to use this as a trader is for options trading. If you are trading options, this can be even more powerful as it shows us the time and value, but now we can better gauge puts and calls. In this same example, it would be fairly evident tha...

	Comparing Prices to the Cloud
	To compare how past events worked with the cloud, we can return to the Price, Volume, and Event Markers tab.
	This tab shows the chart with yellow markers.
	It is important to note that they are not indications to get in and out of trade, these are markers showing each time that the technical signal occurred.
	If you select any of the event markers, the forecast cloud displays using any data from the selected event marker back. This distinction is important as it is showing how the cloud from that date back would have worked. It is a visual backtest of the...
	Here is an image of the last event.
	It is interesting to note that for the most part, the price stays contained within the probability cloud. There are times that it tries to break out of the cloud. When price achieves a top of the probability or bottom of probability, then it tends to...
	At this point, please note a distinction. The probability cloud on the chart only calculates on data from the selected event back. As new data comes in the chart on this tab is not updated. So it can be visually tested.
	The cloud displayed in the Forecast Cloud tab includes all load data, both before and after the event. That allows Forecaster to build a more relevant cloud.
	These two events are from the same event but note that while the primary shape and curves are the same, the coloring is becoming more statistically important while new data comes in.
	It is important to use both clouds together to help understand the direction of price and your current place in price.
	There may be times when working with the Forecast that the Probability cloud has no clear direction as the example below.
	This does not mean that the Forecaster is not working. It simply means that the price did not give a clear and meaningful probability. That means that it is best to avoid the signal and avoid a trade that does not provide a clear direction based on t...
	The Forecaster is a critical tool for traders to help understand the timing and movement of their trades. Using this tool as a guide to entries, exits, stops, and targets can help improve the odds of success in trading.
	See the related video at www.metastock.com/upm


	Chapter 7 Filtering and Forecasting
	This chapter discusses how to find opportunities in the market using the explorer and then go directly to the Forecaster with the list. As discussed before, the ability to find a trade and then move directly into managing it is an important part of t...
	Scanning for Events
	In the Explorer, we matched the 67 event recognizers with an exploration. That allows us the ability to quickly pick an event, scan for it, and then Forecast.
	Click to open the Power Console.
	Select in the Power Console.
	This example uses the Forecaster - Moving Avg 50 Cross Up (The close has crossed above a 50 period simple moving average on increasing volume) against the S&P 500 Stocks.
	Choose the Exploration: Forecaster - Moving Avg 50 Cross Up and the S&P 500 Stocks in the Power Console.
	Use the defaults settings in the Explore tab and set the time frame to Daily to match the Forecaster.
	After completing these selections, choose .
	This starts the Exploration.
	The report appears.
	The following information displays with the results of the scan. (Note that each exploration shows different information as part of the results):
	Value of the 50 Day Moving Average
	In this example, there is one result from the S&P 500 that is crossing the 50-day moving average. Double-click on the result to have MetaStock open the chart. If there were multiple results, you could highlight all the results and then click .
	Charts open for all of the selected results.
	From the chart, you can see that it has crossed the above the 50-period simple moving average and that it has increasing volume. Note that this does not plot automatically and you would need to add these for visual purposes. We added the circles for ...

	Opening Forecaster Analysis from Charts
	To send the open chart to the Forecaster right-click in the white space, and a dialogue box appears. From there, select the Forecaster option.
	This opens Forecaster and makes the selected instrument available to analyze.
	However, when the Forecaster opens, it does not automatically default to the recognizer used by the exploration. Choose the matching exploration in the Recognized Event box.
	Once selected, this gives the correct Forecast cloud to match the exploration.
	From this Forecast Cloud, you can observe that after a cross above a 50 day Moving Average on ADM, the price tends to rise over the next 30 days. It shows a maximum increase of 10% in high probability range and 15% in the lower probability range.
	Since this is a current signal (event), the cloud could be used from the starting point and then monitored as part of a trade setup, if you took the trade.
	You can do the same with the other open charts in MetaStock. By right-clicking and then choosing Forecaster in the menu, you can open several charts.
	These tabs allow you to selecting through multiple charts by clicking the different tabs.

	Optional Workflow:
	As an optional workflow to open charts, a user can run the Exploration then go back to the Power Console, choose the Forecast tab, select the Results of Last Exploration tree to open all charts.
	See the related video at www.metastock.com/upm


	Chapter 8 Forecasting Using Chart Patterns
	Hidden inside every chart is a story - a story about where the price has been and where it might go in the future. Some stories are obvious. Others are a little more difficult to figure out.
	Charts tell these stories with patterns. Chart patterns are pictures or formations made by the price movements of the stocks or commodities you're examining. Numerous studies have repeatedly shown that these patterns have excellent predictive value. ...
	There are two ways to work with patterns in the Forecaster. One is to hand draw patterns; the second is to copy patterns directly from a chart. This workflow demonstrates both methods.
	Hand Drawn Patterns
	To begin click to open the Power Console
	Choose the Forecaster Tab .
	Enter an instrument to begin. For this example, select Apple (Symbol: AAPL.O).
	After selecting an instrument, click .
	The Forecaster application then opens with the default settings.
	Select the Recognizer Library Tab.
	This tab displays a list of all built-in recognizers. When this is displayed click the button.
	That button the Price Pattern Editor
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	For this example a v Pattern will be used.
	To draw a pattern start in the Pattern Shape, Location and Orientation box. Start in the corner and hold down your left mouse button while you draw a pattern. The pattern appears as you draw it. After you finished the pattern, let go of the mouse. Yo...
	This example shows a hand-drawn pattern in the shape of a V. A few notes on the Price Pattern Editor. 1) It is helpful to change the Approximate Price Bars to reflect the length of time that your pattern could show. The default is 15 bars, but this e...
	The Pattern Quick-Test shows you a percentage similarity that allows you to scroll through the chart to display how the pattern matches your chart. You can choose which Security to display. Now that the pattern is done click the Button to save the pa...
	Your pattern now shows in the Event Recognizer Library. They display in alphabetical order.
	The Forecaster cannot display the pattern on the chart yet. Click the button to look for the patterns.
	Once you have selected the button the pattern appears in the drop-down list of available events if the pattern has enough recognized patterns.
	Here the pattern is displayed in the list. Remember you can sort the list in different ways so the event may be in different places based on rank. We sorted this list by recognizer name.
	In this example, the pattern shows 13 times on Apple.
	The chart displays a pattern quick match and how well the event was recognized. Put the cursor over any of the event markers. Forecaster then displays the pattern with a graphical display of the pattern match.
	Select the Forecast Cloud tab.
	The Forecast Cloud is displayed. To review the differences between the Clouds in the Forecast Cloud tab and the Prices tab, see “Comparing Prices to the Cloud” on page 82.
	This pattern shows a high tendency to move up after a V Shape event. The cloud shows a tendency to move up within the first 14 days with a deviation after 30 days. Using this pattern would be most useful within the first 25 days before the deviation ...
	At this point, we should review the last event marker on the Price, Volume, and Event Markers tab.
	Choose this tab and then click the last event marker arrow. After highlighting the last event marker, the pattern turns yellow, and the confidence test appears. The result for this event is recent (within one bar), so the pattern displays at the end ...
	We can see the high probability in the chart and can use this to help set our price and time targets as described in the Forecaster chapter.

	Copying Patterns from Charts
	The second way to set up chart patterns is to copy them directly from the chart. There are several ways to identify patterns with charts. 1) To find a pattern that you see repeat within a chart and copy it or 2) To copy the last pattern that is occur...
	Coca Cola (Symbol: KO) is the example in this workflow. The image below shows that the MACD has a current buy opportunity. If this opportunity were taken it would be a strong benefit to know if the current price pattern will give a strong directional...
	To open the Forecaster from an open chart, right-click in the clean space and then choose Forecaster.
	When the Forecaster opens, select the User-Defined Pattern Select Box and then drag around the pattern to be selected. The gray box on the chart emphasizes this.
	IMPORTANT: The selected pattern must be at least 3 bars long and cannot exceed 250 bars.

	The dialogue box then prompts to capture the selected area as a user-defined pattern
	Select the button. Now the Price Pattern Editor box appears, and you can edit the variables.
	The box shows the pattern in the Pattern, Shape, and Orientation box. Any of the points can be modified by selecting the waypoints and dragging and dropping. The Approximate price bars equals the pattern you s on the chart. Before saving the pattern ...
	Note that on the Pattern Quick-Test that the Pattern matches 100% since it was selected directly from the chart. Click the button and then the button.
	Forecaster now recognizes the pattern on the KO chart.
	In this example, it is recognized 30 times on the medium setting.
	Choose the Forecast Cloud tab to see the most current Forecast Cloud.
	This example shows that after this price pattern occurs that price tends to rise about 10% over 45 days. So if you traded this, it would make sense to target a max price at 10% above the current price and set a stop at the cloud bottom.
	Switch back to the Price, Volume, and Event Markers to see the current forecast cloud for the event. After choosing the tab, select the latest event.
	Below is an example of a previous opportunity using the same pattern on KO. Notice the strong following of price in the probability cloud.
	Price Patterns are powerful, and using them in the Forecaster is especially powerful. Understanding the direction of price after a pattern can give us as traders a better understanding of the recurring movements of price after a price pattern. Using ...
	See the related video at www.metastock.com/upm


	Chapter 9 Understanding the RMO
	About the RMO
	The Rahul Mohindar Oscillator (RMO) and its associated MetaStock tools were developed by Mr. Rahul Mohindar of Viratech Software (viratechsoftware.com). In addition to being a trader and a trainer, Mr. Mohindar is a panelist on both CNBC and CNN India.
	The RMO can be used across any timeframe and for any instrument. It is designed to work with data that provides Open/High/Low/Close. To apply the RMO to a chart:
	Click to open the Power Console.
	Select in the Power Console.
	Enter Symbol and Choose RMO Trade Model from the Apply template option in the Attachment section of the chart dialogue
	Click .
	Your chart then opens with the RMO Trade Model template applied.
	The RMO is a rule-based system that requires multiple criteria to allow for entry or exit confirmation. The rules of the system are set up to allow the RMO user to manage their trades quickly. The first set of rules applies to both position and real-...

	Rules of the RMO
	2. The second window contains SwingTrd2, which is pink (Swing Trade 2) and SwingTrd3, which is purple (Swing Trade 3). These two indicators are designed to help us see the medium-term and long-term trends. SwingTrd2 represents the medium-term trend, ...
	3. The color of the price bars and the buy and sell alerts are directly tied to the SwingTrd2 and SwingTrd3 indicators. In rule 2, we discussed that when SwingTrd2 and SwingTrd3 cross, we have a change in strength. The red and blue arrows shown in th...
	To identify trading opportunities
	1
	a. Bullish or Long Trade
	b. Bearish or Short Trade

	2
	3
	a. Place your stop a couple of ticks below the previous bar low.
	b. If the current bar is lower, place your stop a couple of ticks below the current bar.
	c. If you are in a long position, move the stop up with each new buy alert. (This may also be an opportunity to add to your position.)

	4
	a. Don't use this indicator unless you are in a profitable position.
	b. The exit swing indicator has two horizontal lines. The top line is red, and the bottom is blue. If you are in a long position and the exit swing indicator falls below the red line, consider putting in a trailing stop.
	c. Likewise, if the exit swing indicator crosses above the blue line and you are in a short position, consider putting in a trailing stop.




	RMO Explorations
	The following explorations match the rules of the RMO that we have just learned, however, the terminology is a little different. Let's work through the rules and understand what each exploration does.
	These explorations can be used in any combination to identify trading opportunities. You can use one of the explorations by itself or combine multiple explorations. The best way is to use combinations of the bullish explorations (RMO Bullish Zone, RM...

	Explore for opportunities using the RMO
	Now that you understand the rules of the RMO, you can use the functions built into The Explorer in MetaStock. The Explorer has six explorations that match the rules of the RMO.
	Click to open the Power Console.
	Select in the Power Console.
	Scroll down and select the three bullish RMO Explorations and the desired list to scan.
	Makes sure to select the "Use the results from the preceding exploration". This option uses our single chosen list of instruments to filter through all three criteria.
	See the related video at www.metastock.com/upm


	Chapter 10 New Features
	Bonus Features in MetaStock 17
	This chapter discusses some of the new features inside MetaStock 17. We covered the QuoteCenter and OptionScope in "MetaStock Power Tools Overview" on page 20. Please refer to that chapter for help on those features. This chapter covers some of the o...

	Feature 1 - Pre/Post Market Data - MetaStock R/T only
	Pre/Post market data allows you to be able to view the market data that happens before the official market open and after the official market close. Some exchanges offer the ability to chart/view this data. It may be beneficial as the market draws to...
	In the image below is a chart of Ford (F) in a 5-minute chart.
	Now let’s look at the same chart with pre/post-market turned on. To do this, we are going to duplicate the current window and view the charts side-by-side. To do this go to Window | New Window.
	After this, we want to view them side-by-side, so select the column icon in the Standard Toolbar.
	We now have the two images side-by-side.
	To turn pre/post-market data on in one chart right click on the white space of a chart and the go to Chart Window Properties.
	Next, select the Trading Sessions Tab and then Select Include Pre and Post Market then choose OK.
	Now the two charts look very different. The one on the left is the standard market, and the right includes pre/post-market data.

	Feature 2 - Clear Smart Charts
	Smart Charts in MetaStock are a powerful feature that allows you to make changes to a standard chart and have MetaStock automatically save your notes, indicators, applied experts, and line studies. Then the chart can be closed, and MetaStock still re...
	MetaStock displays a warning explaining what it is about to deleted if you proceed.
	Once you choose Yes, MetaStock clears your Smart Charts.

	Feature 3 - Back up your user files
	From time to time, everyone feels the need to make sure everything is backed up. That is why MetaStock 17 includes the feature to be able to back up all your files.
	To back-up your files, go to File | Back Up User Files
	MetaStock then asks where to save the user files. It defaults to the MetaStock Folder. You can change this, but the MetaStock folder is the preferred location.
	Choose Select Folder to finish backing up your user files. If you want to restore a user file, it is recommended to call support.

	Feature 4 - Easier access to reports
	We’ve made it easier to access previous reports from Explorations and System Tests. This example shows the Explorer, but the process would be the same on the System Test tab.
	Click on in the Power Console. An “<R>” denotes any explorations you ran previously.
	Now to access all reports, you can choose the Report button in the Explorer Tab or System Test Tab.
	Once that is selected, MetaStock presents you with the option to view all reports or selected reports. In this example, there are none selected, so the only option presented is the option to view all reports.
	It then displays all previously run explorations.
	Remember this option is also available on the System Test tab.

	Feature 5 - Create a Watchlist of Options.
	This workflow assumes that you’ve followed the instructions included the introduction to the Power Tools and have the ability to open OptionScope. If you did not, please refer back to those instructions.
	Here you can view a narrowed down view of options in the OptionScope product.
	Here we are going to create a watchlist of these options in MetaStock. To do this, highlight the Calls/Puts that you want to select.
	To select, highlight the first one and then drag down while holding CTRL.
	After highlighting these, right-click and select Copy to Clipboard.
	Return to MetaStock and go to the Power Console. From anywhere in the Power Console choose Custom List.
	When the Custom List manager is displayed, choose New | Online Instruments
	Give the list a name. In this example used My Options.
	After that, right-click in the white space and choose Paste.
	That inserts the symbols into the custom list manager. After they appear, click save.
	From here these symbols are now included in your custom lists in the Power Console. You can use this list to Chart/Scan/Back Test/ or even Forecast!


	Chapter 11 Working with Local Data
	Creating a new List
	MetaStock XV added the advantage of allowing a user to be able to read several different local data formats. It can read MetaStock Legacy File Format, CSV, or our new and improved local data format called MSLocal. Local data gives a user the flexibil...
	This chapter covers how to add local data files to your MetaStock so you can use them in your workflows. It does not cover how to create or manage your local data files. Refer to the MetaStock help or other resources on how to create and maintain you...
	To add existing local data files to MetaStock:
	Click to open the Power Console.
	Select to open the Chart tab.
	To add local data files right click on the word Instruments in the Instrument Tree. The option to manage Public Lists or Custom List is displayed.
	Select the option to Manage Custom Lists.
	The custom list manager is displayed.
	In the custom list manager select the button and select Local Instruments.
	This takes you to the New Custom List dialogue box.

	Adding Instruments to the List
	It is effortless to add a full folder of securities to your folder. Start by selecting the button.
	The Local Instruments box is displayed.
	From here we need to what folder is to be added into the local data library. In the Local Instruments box, select .
	At this point, you need to navigate to the folder that holds your data. As that may be different for each user, we use a generic example. Navigate to the folder that contains your data.
	This example selects the “MYData” folder. Select the folder you want to load and then choose the button.
	All the compatible data files in that folder are selected.
	Here is what each column means.
	Note that all the files are now selected automatically (denoted by a gray or blue color). To add to the list, select the button.

	Saving the New List
	The files are loaded into the custom list. MetaStock automatically uses the folder name for the list name. There is no need to create a new folder name.
	Select .
	The folder now shows in the Custom List Manager.
	Repeat this process for all folders that you want to load into MetaStock. If you have finished loading lists, choose .
	The list of instruments is now available in the Power Console.
	Now that the Power Console includes the list, you can use it for any workflow. You can Open Charts, Explore, Test, and Forecast from this list.

	See the related video at www.metastock.com/upm


